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製品概要

Dell 1081AD/2161AD Server Console Switch(SCS)は、データ・センター・サー

バーへのフレキシブルな中央集中のローカル・アクセスを提供するアナログ・キー

ボード、ビデオ、マウス( KVM)スイッチです。また、このスイッチは、オプションのリ

モート・アクセス・キー( RAK) が一緒に使用される場合はデータ・センター・サー

バーに中央集中のリモート・アクセスも提供します。

特長とメリット

ケーブル量の低減

デバイスの密度が継続して高まるに伴い、ネットワーク管理者にとってはケーブル

量が大きな関心事になっています。 SCSは、革新的なサーバー・インターフェイ

ス・ポッド( SIP) と単一の、業界標準である非シールド・ツイスト・ペア( UTP) ケーブ

ルを活用して、ラック内のKVMケーブル量を大幅に削減します。これによって、エ

アフローを大きくして、冷却能力を増やしながら、デバイス密度をさらに高くするこ

とができます。

SIPインテリジェント・モジュール

SCSは、ターゲット・デバイスから直接電力が供給されるSIPをサポートしているた

め、スイッチに電源が入っていないときも「Keep Alive」機能を提供します。 CAT 5

設計を採用したSIPでは、ケーブルの乱雑状態が大幅に解消され、また最適な解

像度とビデオ設定が提供されます。 SIPの内蔵メモリにより、固有のデバイス名ま

たは電子ID( EID) が個々の接続デバイスに指定され保持されるため、構成が簡単

になっています。

PS/2とUSB SIPが使用可能で、KVMをデバイスに直接接続できます。 USB2およ

びCAC用SIPも利用できます。 SCSは、8または16個のARIポート付きで提供されて
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います。これらのポートはSIPをSCSに接続するために使用されます。 SIPを利用

することで、追加のスイッチを接続してSCSシステムを拡張できます。 この柔軟性

により、データ・センターの拡大に伴う容量の増大が可能になります。

マルチプラットフォームのサポート

Dell SIPをSCSと組み合わせて、PS/2、USB、USB2、USB2およびCAC用の各デ

バイス環境との接続をサポートします。

相互運用性のあるAvocent® IQモジュール・インテリジェント・ケーブルを使用して

も、ローカル・デバイスをSCSに接続できます。PS/2、USB、Sun®モジュールのオ

プションが使用可能です。詳細については、ご使用の製品に対応するアボセント

製 品 の「 イ ン ス トー ラ／ ユー ザー・ ガ イ ド」 を 参 照 す る か、 ま た

はavocent.com/manualsで確認してください。

ユーザー・インターフェイス

SCSには、SCSをローカルで管理するための「ポイント・アンド・クリック」インター

フェイスである OSCAR™と称されるローカル・ユーザー・インターフェイス( UI) およ

びOBWI( On-Board Web Interface) の2つが搭載されています。これらのインター

フェイスによって提供される構成オプションを使用することにより、SCSを特定のア

プリケーションに合わせてカスタマイズすることができます。 OBWIはまた、接続さ

れているデバイスにアクセスして制御するのにも使用でき、基本的なKVMニーズ

をすべてリモードで取り扱うことができます。

注: OBWIを介したリモートKVMセッションには、Dell RAKのインストールが必要です。

OSCARインターフェイス

ローカル・ポートを使用してアクセスする、OSCARインターフェイスは、SCSとデバ

イスを構成するための直観的なメニューと操作モードを特徴としています。個々の

デバイスは、名前、EID、またはポート番号で識別されます。

OSCARインターフェイスでは、スクリーン・セーバー・パスワードを使って、システ

ムを保護することができます。 スクリーン・セーバー・モードが起動しているとき

は、正しいパスワードを入力してシステムを再起動させるまでアクセスができなくな

ります。 パスワード・ダイアログに Helpとタイプ入力すると、Dellテクニカル・サ

ポートに接続されます。 SCSの推奨される用途は、ファイアウォールによって保護

されたデータ・センター・インフラストラクチャー内です。
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OBWI

OBWIを使用して、SCSを管理することもできます。 OBWIは、SCSから直接起動さ

れるので、ソフトウェア・サーバーや他のインストールは必要ありません。オプショ

ンのDell RAKをインストールして追加すれば、ターゲット・デバイスに対するリモー

トKVMおよびバーチャル・メディアのセッションを確立することもできます。詳細に

ついては、「Dell リモート・アクセス・キー( RAK) 」( ページ4) を参照してください。

ターミナル・コンソール・インターフェイス

ターミナル・コンソール・インターフェイスには、「10101」セットアップ・ポートを介し

てアクセスします。 ターミナル画面またはターミナル・エミュレーション・ソフトウェ

アを実行しているPCを使用してこれらの画面にアクセスできます。

バーチャル・メディアおよびスマート・カード対応スイッチ

SCSでは、ローカル・メディアまたはスマート・カードにあるデータを表示、移動、お

よびコピーすることができます。 スマート･カードは、コンピューター、ネットワー

ク、セキュリティ保護の部屋や建物へのアクセスを可能にする識別／認証情報を

含む情報を保管、処理するポケットサイズのカードです。

バーチャル・メディアまたはスマート・カード･リーダーは、SCSのUSBポートに直接

接続できます。 さらに、バーチャル・メディアまたはスマート・カード・リーダーは、

リモートのOBWI、SCSソフトウェア、Avocent管理ソフトウェアのいずれかを実行し

ている任意のリモート・ワークステーションに接続でき、イーサネット接続を使用し

てSCSに接続されます。

注: ターゲット・デバイスとのバーチャル・メディアまたはスマート・カードのセッション
を開始するには、最初にUSB2またはUSB2およびCAC用SIPを使用してターゲット・
デバイスをSCSに接続する必要があります。

IPv4およびIPv6機能

SCSは、現在使用されているインターネット･プロトコール･バージョンであるIPv4ま

たはIPv6を使用するいずれのシステムにも対応しています。 IPv4またはIPv6モー

ドへのネットワーク設定の変更は、ターミナル・コンソール、OSCARインターフェイ

ス、またはOBWIから実行できます。
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標準TCP/IPネットワークを使用したSCSへのアクセス

デバイスには、標準TCP/IPネットワークを介して構成するためのアクセス可能で

す。オプションのDell RAKがインストールされている場合は、接続されているすべ

てのシステムにイーサネットを介してアクセスすることができます。「Dell リモート・

アクセス・キー( RAK) 」( ページ4) を参照してください。

注: クライアントは、インターネット・ブラウザを使用してSCSに接続します。

注: KVM over IPセッションは、Dell RAKがインストールされているときにサポートされ
ます。

アップグレード可能

SCSとSIPのアップグレードは随時可能です。アップグレードは定期的に行い、常

に最新のファームウェア・バージョンで稼動してください。 アップグレード

は、OSCARインターフェイス、OBWIまたはターミナル・コンソール画面から開始す

ることができます。 SCSはSIPの自動ファームウェア・アップグレードを実行するよ

うに構成することもできます。詳細については、「ツール－再起動およびアップグ

レード」( ページ67) を参照してください。

2階層拡張

SCSでは、プライマリSCSの各ARIポートから追加のSCS、CSまたはRCSを1台ティ

ア接続することができます。ティア接続された各SCSは他のデバイスと同じ方法で

接続します。 装置にこのようにティア( 階層) を追加することで、1つのシステム内

に最大512台のサーバーを接続できます。「SIPを使用したスイッチのティア接続」(

ページ27) を参照してください。

Dell リモート・アクセス・キー( RAK)
オプションのDell RAKは、USBポートにインストールされ、以下の機能をサポートし

ます。

KVMリモート・アクセス

RAKの使用で、単一のKVMリモート・ユーザーがサポートされます。 RAKの使用に

より、オペレーティング・システムのインストールや回復、ハード・ドライブの回復や

複製、BIOSの更新、およびサーバーのバックアップなどをリモートで管理すること

ができます。
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Avocent管理ソフトウェアのプラグイン

SCSでAvocent管理ソフトウェアを使用すると、単一のWebベースのユーザー・イ

ンターフェイスから、複数のプラットフォームにあるターゲット・デバイスのセキュ

アなリモートからのアクセスおよび監視がIT管理者により可能になります。デバイ

スへのセッションが、1つのアクセス・ポイントから確立できます。 詳細について

は、管理ソフトウェア・プラグインの「技術告示」を参照してください。

ローカル・ビデオ・スケール

SCSでは、SCSとデバイスを分離するケーブルの長さによっても変わりますが、ビ

デオ信号を1600 x 1200または1680 x 1050( ワイドスクリーン)の最大ピクセル解

像度を使ってデジタル化します。

暗号化

SCSでは、キーボード／ビデオ／マウスのセッションとバーチャル・メディア・セッ

ションの128ビットSSL( ARCFOUR) 、AES、DES、3DES暗号化がサポートされてい

ます。
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図1.1: Server Console Switchの構成例

番号 説明 番号 説明

1 UTP接続 5 イーサネット

2
Server Console Switchへ
のローカルKVM接続

6

デジタル・ユーザー( OBWIまたはRCSソ
フトウェア用のインターネット・ブラウザ

を搭載したコンピューター、および／ま

たはAvocent管理ソフトウェア・サー

バー( Dell RAKが必要) )

3 リモート IP接続 7
ローカル・アナログ・ユーザー( OSCAR
インタフェースおよび／またはローカ

ルLCDトレー)

4
Server Console Switch (
図は、2161AD)

8 サーバー／ターゲット・デバイス

表 1.1: 図 1.1の説明
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安全に関する注意事項
本マニュアルはDell 1081AD/2161AD Server Console Switchのみを対象としてい

ます。以下の安全に関する追加の指示も参照してください。

• Dell安全シート

• Dell RTF規制技術告示

一般
身体の安全を守り、使用システムや作業環境を損傷から保護するために、次の安

全に関するガイドラインに従ってください。

注意: システムの電源は高電圧および高エネルギーを発出して人身に危害を及ぼ

す可能性があります。 カバーを取り外してシステム内のコンポーネントにアクセスす

るといった作業は、必ず訓練を受けたサービス技術者に任せてください。 この警告

は、Dell™ Server Console Switch、Dell™ PowerEdge™ サー バー およびDell

PowerVault™ ストレージ・システムに適用されます。

• サービス・マークを確認し、その指示に従います。

• Dellシステムのマニュアルに記載されている以外の修理、メンテナンス作業

は行わないでください。

• 電光のイラストの三角形記号が付いているカバーを開くと感電の危険があり

ます。

• これらの格納区画内の部品については、訓練を受けたサービス技術者だけ

が修理を行います。

• 本製品には修理可能な部品は含まれていません。 ユニットを開けようとしな

いでください。

• 次のいずれかの状態が発生した場合は、電源コンセントから製品の電源ケー

ブルを抜いて、部品を交換するか、Dell認定サービス業者に問い合わせてく

ださい。

• 電源ケーブル、延長コード、または電源プラグが破損した。

• 製品内部に物体が落ちてしまった。
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• 製品が水に晒されてしまった。

• 製品を落としたか、破損させた。

• 操作手順に従っても製品が正常に作動しない。

• システムは暖房器具や熱源から離して設置してください。また、冷却用の通気

孔をふさがないでください。

• システム・コンポーネントに食べ物や液体をこぼさないでください。また、水分

のある環境では製品を操作しないでください。システムに水が入った場合、ト

ラブルシューティング・ガイドの該当する項を参照するか、認定サービス業者

にお問い合わせください。

• 本製品は必ず認定機器のみと併用してください。

• カバーを外す／内部コンポーネントにアクセスする際は、製品が常温に戻っ

てから行ってください。

• 必ず、電気定格ラベルに記載の外部電源タイプを使用して製品を作動してくだ

さい。適合する電源タイプが不明の場合は、認定サービス業者または地域の

電力会社にお問い合わせください。

注:システム破損を避けるため、電源装置の電圧選択スイッチ(備わっている場合)
は、必ずご使用地域のAC電源に適合した電圧になるよう設定してください。 また、モ
ニターと接続デバイスの電気定格が適切であることを確認してください。

• 使用モニタおよび周辺機器の電気定格が設置場所の電源に適合していること

を確認してください。

• 必ず本製品に付属の電源ケーブルのみを使用してください。

• 感電を避けるため、システムおよび周辺機器の電源ケーブルは、正しい方法

でアース処理されたコンセントに接続してください。 これらの電源ケーブル

は、正しくアースするために、三本ピン・プラグが使用されています。 アダプ

ター・プラグを使用したり、アースピンをケーブルから取り外したりしないでくだ

さい。

• 延長ケーブルおよびケーブルタップは定格に従って使用してください。電源ス

トリップに接続する製品全部の合計定格アンペアが電源ストリップの最大定

格アンペアの80%を超えていないことを確認してください。
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• 突発的に起きる一時的な電源の増減からシステムを保護するために、サー

ジ・サプレッサー、ライン・コンディショナ、または無停電電源装置( UPS) を使

用してください。

• システム・ケーブルおよび電源ケーブルは慎重に配置してください。ケーブル

は踏んだりつまずいたりすることのない形で配線してください。ケーブルには

何も載せないでください。

• 電源ケーブルやプラグは改造しないでください。設置場所での電気的改修に

ついては、有資格の電気技術者または地域の電力会社にお問い合わせくださ

い。必ず使用の地域または国の配線規定に従ってください。

LAN関連の注意事項
• 雷雨中のLANへの接続や使用は避けてください。雷によって感電する危険が

あります。

• 湿潤環境でのLANへの接続や使用は避けてください。
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インストール

SCSではイーサネット上の通信にTCP/IPが使用されます。 最適なシステム・パフ

ォーマンスのためには、専用スイッチ付き100BaseTネットワークを使用します。

10BaseTイーサネットを使用することもできます。

ターミナル・ソフトウェア、OSCARインターフェイズまたはOBWIを使用してSCSシス

テムを管理することができます。 OBWIでは1台のスイッチとその接続を管理しま

す。オプションのDell RAKとともに、OBWIまたはAvocent管理ソフトウェアを使用

すると、KVMとシリアル・スイッチング・タスクを実行することもできます。 Avocent

管理ソフトウェアの詳細については、http://www.avocent.com/dellを参照してく

ださい。

注: RCSソフトウェアを使用すると、他のスイッチを管理できます。 詳細については、
ご使用の製品に対応する「インストーラ／ユーザー・ガイド」を参照してください。

注:いずれのスイッチも最新バージョンのファームウェアに更新されていることを確認
してください。 OBWIを使用したスイッチのアップグレードに関する情報については、「
ツール－再起動およびアップグレード」(ページ67) を参照してください。

はじめに
下記のアイテムが、SCSの同梱品として含まれています： SCSを設置する前に、

正しく設置するために必要なアイテムを手元に準備してください。

• Server Console Switch

• 電源コード

• 0U取り付け用ブラケット・キット

• 1U取り付け用ブラケット・キット(追加のレール2本がSCSアッセンブリーに事

前に装着済み)

• 10101 コンソール・セットアップ・ポート用のケーブルとアダプター
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• ユーザー・マニュアル収録CD

• Server Console Switchクイック・インストール・ガイド

• Dellラック収納クイック・インストール・ガイド

• Dell安全シート

• Dell RTF規制技術告示

この他に必要なアイテム：

• Dell SIPまたはAvocent IQモジュール(接続するデバイスごとに1個)

• CAT 5パッチ・ケーブル(最高30 m) 、接続デバイス1台につき1本

オプションのアイテム：

• Dell リモート・アクセス・キー( RAK)

• ポート拡張モジュール( PEM)

注: PEMを介してデバイスが接続されていると、バーチャル・メディア・セッションまた
はCACセッションは開始できません。

ネットワークの設定
SCSはIPアドレスを使用して、SCSと接続されているデバイスを個別に識別しま

す。 SCSは、Dynamic Host Configuration Protocol( DHCP) と静的IPアドレスの両

方をサポートします。 IPアドレスを各SCSに予約して、SCSがネットワークに接続し

ている間、各IPアドレスは静的のままになるようにします。

キーボード

USBキーボードおよびマウスをSCSのアナログ・ポートに接続することができま

す。

注:また、SCSは、アナログ・ポートに対する複数のキーボードやマウスの接続にも対
応しています。 ただし、同時に複数の入力機器を使用すると、予期しない結果を生じ
ることがあります。
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SCSクイック・セットアップ
次にクイック・セットアップを一覧で示します。ラック収納および設置の詳しい手順

については、「スイッチのラック収納」( ページ14) を参照してください。

1 SCSを開梱してコンポーネント全部が正しい状態で揃っていることを確認しま

す。

2 SCSハードウェアを設置し、SIPまたはAvocent IQモジュールを各ターゲット・

デバイスまたはティア接続されたSCSに接続します。 各SIPまたはAvocent IQ

モジュールをCAT 5ケーブルを使用してSCSに接続し、さらにキーボードとモ

ニター、およびマウス・コネクターをSCSのアナログ・ポートに接続します。

3 ローカル・ポートの周辺機器をSCSの背面パネルにある適切なポートに接続

し、ネットワーク構成をセットアップします。 IPアドレスはここから、またはRCS

ソフトウェアから設定できます。 Dellでは静的IPアドレスの使用を推奨します。

4 ローカル・ポートの接続については、OSCARインターフェイスまたはOBWIを使

用して、すべてのデバイス名を入力してください。

5 それぞれのサーバーでマウスの加速度をSlowまたはNoneに調整してくださ

い。

RCSソフトウェアをセットアップするには( リモート・コンソール・スイッチ・ソフトウェ

アのユーザー・ガイドを参照してください) ：

1 各クライアント・ワークステーションにRCSソフトウェアをインストールします。

2 1つのクライアント・ワークステーションから、RCSソフトウェアを起動します。

3 RAKがインストールされている場合は、New Server Console Switchタスク・ボ

タンをクリックして、新しいスイッチをRCSソフトウェア・データベースに追加し

ます。前述のとおりにIPアドレスが構成されている場合は、Yes, the product

already has an IP addressを選択し、それ以外の場合は、No, the product does

not have an IP addressを選択します。

RCSソフトウェアはスイッチとスイッチに接続されているすべてのSIPを検

出し、Explorer内に名前を表示します。

注: RCSソフトウェアを使用すれば、Dell SCS、Dell RCSおよびAvocentスイッチの一
部を追加して管理することができます。
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4 Explorerを使用してプロパティを設定し、目的に従ってデバイスをロケーショ

ン、サイト、またはフォルダにグループ分けします。

5 OBWIを使用して、ユーザー・アカウントを作成します。詳細については、「ロー

カル・ユーザー・アカウントの設定」( ページ77) を参照してください。

6 このファイルを読み込んだ後で、ローカル・ユーザーがいずれかのSIPの追

加、削除、名前の変更を行った場合、SCSを選択してResyncをクリックすると、

ローカルSCSを再同期化できます。接続されているデバイスを制御するに

は、Explorerでデバイスを選択してConnect Videoタスク・ボタンをクリックし、

ビューアでデバイス・セッションを起動します。

7 ビューアでView →Scalingを選択して解像度を、View →Colorを選択してデバ

イスの画質を調整します。

スイッチのラック収納
スイッチは、ラックの棚、または直接19インチ幅のEIA-310-E準拠のラック( 4ポス

ト、2ポスト、ネジ穴式)に設置できます。 1U前面ラック、1U背面ラック、および2ポ

スト設置用に、Dell ReadyRails™システムが用意されています。 ReadyRailsシステ

ムには、個別に梱包されたレール組立部品が2組と、スイッチの側面に取り付けら

れて同梱されるレール2本が含まれます。 さらに、0U構成用に取り付け用ブラケッ

トが1つ、背面ラック設置用にブランク・パネルが1枚付属しています。

警告: この説明はあくまで参考のためのものであり、要約されています。 始める前

に、「安全、環境、および規制に関する情報」の小冊子に記載されている安全に関す

る指示をお読みください。

注: この文書中の図は、特定のスイッチを表すものではありません。

機器をラックに収納する際の安全措置

• ラックへの収納について：ラックに過負荷や不均一な負荷をかけると、棚やラ

ックの故障の原因となり、機器および身体に対する損傷を引き起こすことがあ

ります。設置を始める前に、まず最終設置箇所にラックを固定させてください。

コンポーネントをラックの底部から収納していき、上に向かって作業を続けて

ください。ラックの荷重定格を超えてはいけません。
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• 電源に関する注意事項：装置指定の電源以外には接続しないでください。複

数の電気コンポーネントをラックに設置する場合は、コンポーネントの総出力

定格が回路容量を超えないことを確認してください。電源および延長コードが

過負荷状態となると、火災やショックの危険性が生じます。

• 周辺温度の上昇：密閉型のラック・アッセンブリに取り付けられている場合、ラ

ック内の動作温度が室温より高くなることがあります。スイッチの最高周囲温

度は50°Cです。これを超えないように注意してください。

• 通気の減少：ラックに装置を設置する際には、機器の安全な動作に必要な気

流の量が損なわれないよう配慮する必要があります。

• 確実なアース接地：ラックに取り付けられた装置については、常時確実なアー

スを確保してください。分岐回路に直接接続以外に給電接続を行う場合は( 例

えば、電源ストリップの使用) 、特に注意してください。

• リア・パネルが下向きになった状態で製品を収納しないでください。

Dell ReadyRailsシステムの取り付け

ReadyRailsシステムを使用すると、スイッチ設置用に、ラックを簡単に構成できま

す。 ReadyRailsシステムは、1Uツールレス方法、または1Uツール方法の利用可能

な3つのうち1つを使用して設置できます( 2ポスト・フラッシュ・マウント、2ポスト・

センター・マウント、または4ポスト・ネジ穴式) 。

1Uツールレス構成( 4ポストの角穴または非ネジ式丸穴)

1 ReadyRailsのフランジの端が外側に向いた状態で、1本のレールを左右の垂

直ポストの間に設置します。 背面フランジのレール・ペグを背面の垂直ポス

ト・フランジに揃えて固定します。図 2.1のアイテム1とその部分拡大図は、角

穴および非ネジ式丸穴の両方のケースでペグが取り付けられた様子を示して

います。
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図2.1: 1Uツールレス構成

2 ラック正面のフランジ・ペグを垂直柱の前面の穴に入るように合わせ、固定し

ます(アイテム2) 。

3 この手順を2番目のレールでも繰り返します。

4 各レールを取り外すには、各フランジの端( アイテム3) にあるラッチ・リリー

ス・ボタンを引いて、各レールを取り外します。

2ポスト・フラッシュ・マウント構成

1 この構成では、各ReadyRailsアッセンブリーの前面からキャストを取り外す必

要があります(図 2.2、アイテム1) 。Torx™ドライバーを使用して、前面フランジ

の端(レールのスイッチ側にある)から2つのネジを取り外し、各キャストを取り

外します。今後ラックで必要になったときのために、キャストは保管しておきま

す。背面フランジ・キャストを取り外す必要はありません。
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図2.2: 2ポスト・フラッシュ・マウント構成

2 ユーザー供給の2個のネジで1本のレールを前面ポスト・フランジに取り付け

ます(アイテム2) 。

3 プランジャー・ブラケットを垂直ポストに向かって前面にスライドさせて、ユー

ザー供給の2個のネジでプランジャー・ブラケットをポスト・フランジに固定しま

す(アイテム3) 。

4 この手順を2番目のレールでも繰り返します。
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2ポスト・センター・マウント構成

1 カチッという音がして所定の位置に納まるまでプランジャー・ブラケットを後方

にスライドさせて、ユーザー供給の2個のネジでプランジャー・ブラケットを前

面ポスト・フランジに固定します(図 2.3、アイテム1) 。

図2.3: 2ポスト・センター・マウント構成

2 背面ブラケットをポストに向かってスライドさせて、ユーザー供給の2個のネジ

でポスト・フランジに固定します(アイテム2) 。

3 この手順を2番目のレールでも繰り返します。

4ポスト・ネジ穴構成

1 この構成では、ReadyRailsアッセンブリーの各端からフランジの端のキャスト

を取り外す必要があります。Torx™ドライバーを使用して、フランジの各端か
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ら2つのネジを取り外し、各キャストを取り外します(図 2.4、アイテム1) 。今後

ラックで必要になったときのために、キャストは保管しておきます。

2 各レールで、ユーザー供給の2個のネジで前面フランジと背面フランジの各端

をポストに取り付けます(アイテム2) 。

図2.4: 4ポスト・ネジ穴構成

スイッチの設置

スイッチは1U背面ラック、1U前面ラック、1U2ポスト( フラッシュおよびセンター) 、

および0U構成に収納できます。次は、1U背面ラック、1U前面ラック、および0U構
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成の例です。 1U2ポスト( フラッシュおよびセンター)構成では、4ポスト構成と同じ

方法で、スイッチをレールにスライドさせることができます。

1U背面ラックの設置

1 スイッチに付いているレールの端をReadyRailsアッセンブリーに挿入し、スイ

ッチをラックに押し入れます(図 2.5、アイテム1) 。

図2.5: 1U背面ラックの設置

2 各スイッチ・レールを蝶ネジで固定します(アイテム2) 。

3 ( オプション) ブランク・パネルをラック前面のレールに取り付け、蝶ネジを固定

します(アイテム3) 。

スイッチをラックから取り外すには次の手順を実行します。
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1 蝶ネジを外し、トラベル・ストップに達するまで、スイッチ・アッセンブリーをラッ

クから引き出します。 トラベルストップの位置は、レールグリップの位置を変え

るためのものであり、修理・交換の対象とはしていません。

2 スイッチ・レールの側面にある青いタブを見つけます(アイテム4) 。

3 タブを内側に押して、スイッチ・レールがReadyRailsアッセンブリーから完全に

離れるまでアッセンブリーを引きます。

1U前面ラックの設置

設置する前に、スイッチに取り付けられているレールを再構成する必要がありま

す。

1 各スイッチ・レールで、前面スタンドオフの下にあるタブを持ち上げ、スイッチ

からレールを持ち上げながらレールを前方にスライドさせます(図 2.6、アイテ

ム1) 。
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図2.6:スイッチ・レールの回転

2 各レールを180°回転させ(アイテム2) 、各レールをスイッチに再度取り付け

ます(アイテム3) 。

3 ReadyRailsシステムでのスイッチ・アッセンブリーの挿入と取り外しについて

は、1U背面ラックの手順を参照してください。

注: この構成ではブランク・パネルは必要ありません。

0Uの設置

1 0U取り付け用ブラケットをスイッチ・レールに揃えて取り付けます(図 2.7、ア

イテム1)蝶ネジを締めます(アイテム2) 。

2 取り付け用ブラケットのフックをラックの穴に挿入し、青いボタンが飛び出して

ブラケットが所定の位置にロックされるまで押し下げます。
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図2.7: 0Uの設置

スイッチ・アッセンブリーを取り外すには、青いボタン(アイテム3) を押してブラケッ

トの固定を外し、アッセンブリーをポストから持ち上げます。

SCSハードウェアの接続
図2.8にSCSの構成の例を示します。

図2.8:基本的なSCS構成
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番号 説明
番

号
説明

1
SCS( 図は16ポート・モ

デル)
7 ACI接続

2 電源コード 8
外付けバーチャル・メディア－ USB
接続

3 アナログ・ユーザー( 2) 9 ターゲット・デバイス・ポート

4
デジタル・ユー

ザー( RAKが必要)
10 SIP

5 LAN／ネットワーク 11 サーバー／ターゲット・デバイス

6
10101コンソール・セット

アップ・ポート

表 2.1: 基本的なSCS構成の説明

注: SCSスイッチは、ACI接続を介しての他のアプライアンスへの接続に対応してい
ます。 この接続では、当該ティア( 階層) のセカンダリ・アプライアンスでACIコネク
ターがユーザー側にあることが必要となります。

SCSを接続して電源をオンにするには次の手順を実行します。

注意:使用機器への感電や損傷のリスクを抑えるため、ジャンパー・コードの接地プ

ラグは無効にせずにそのまま使用してください。 接地プラグは安全上重要な役割を

果たします。 ジャンパー・コードは、常に容易にアクセスできる接地処理されたコン

セントに差し込んでください。 装置の電源を切る際は、電源または装置のどちらかの

側でジャンパー・コードを引き抜いてください。

注:建物に3相AC電源がある場合は、コンピューターとモニターが同じ相になってい
ることを確認します。相が異なっていると、これが原因でビデオやキーボードの機能
が正しく作動しないことがあります。

注: SCSとサーバー間のケーブル長は30 mまでサポートされます。

• 電源コードの接地プラグを無効にしないでください。接地プラグは安全上

重要な役割を果たします。
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• ジャンパー・コードは、常に容易にアクセスできる接地処理されたコンセ

ントに接続してください。

• 製品の電源を切る際は、電源または製品のどちらかの側でジャンパー・

コードを引き抜いてください。

• 本製品の筐体内には、ユーザーが修理できる部品はありません。 製品

のカバーを開けたり取り外したりしないでください。

1 VGAモニター、USBキーボード、およびマウスのケーブルをラベル付きの適切

なポートに接続します。

2 UTPケーブル( 4ペア、最長30 m) の一方の端を、番号が付いた利用可能な

ポートに接続します。もう一方の端をSIPのRJ-45コネクターに接続します。

3 SIPをデバイスの背面にある適切なポートに接続します。 接続するすべての

デバイスについて手順2と3を繰り返します。

注: Sun Microsystemsのサーバーに接続する際は、VGAとSync on Greenの両方ま
たはComposite Sync(複合同期)機能を備えたSunコンピューターに対応するため、
ローカル・ポートで必ずマルチシンク・モニターを使用してください。

4 ユーザーが用意したUTPケーブルをイーサネット・ネットワークからSCS背面

のLANポートに接続します。 ネットワーク・ユーザーはこのポートを介し

てSCSにアクセスします。

5 各デバイスをオンにし、次にSCSに付属のジャンパー・コードを取り出します。

SCS背面にある電源ソケットにコードの一方の端を接続します。もう一方の端

を適切な電源に接続します。

6 ( オプション)バーチャル・メディアまたはスマート・カード・リーダーをSCSの任

意のUSBポートに接続します。

注: すべてのバーチャル・メディア・セッションには、USB2またはUSB2およびCAC
用SIPを使用する必要があります。
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SIPを使用したスイッチのティア接続
図2.9は、SCSとデバイスとの間の代表的なSIPの接続を示しています。

SIPを各デバイスに接続するには次の手順を実行します。

注: デバイスをティア接続するときは、実際のユーザーに直近のSCSがプライマ
リSCSです。

1 お使いのSCS用のSIPを見つけます。

2 PS／2 SIP接続を使用している場合、このSCSに接続する最初のデバイスの

キーボード、モニター、マウスの適切なポートに、SIPケーブルの色別された

端部を接続します。 USB接続の場合には、このSCSに最初に接続するデバイ

スのUSBポートにSIPのプラグを接続します。

3 SIPのRJ45コネクターに、SIPとSCS間に配線するCAT 5ケーブルの一端を接

続します。 「SIP接続」( ページ28) を参照してください。

4 CAT 5ケーブルのもう一方の端を、SCSの後面にある目的のARIポートに接続

します。

5 接続したいデバイスのすべてで2～4の手順を繰り返します。

注:サービスを開始する前にスイッチの電源をオフにします。 必ず、ジャンパー・コー
ドを電源から抜いてください。

注: スイッチのデバイスへの接続には、Dell SIPのほかに、Avocent IQモジュー
ル( Sunモジュールを含む)を使用することもできます。
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図2.9: SIP接続

番号 説明

1 CAT 5

2 USB接続

3 VGA接続

表 2.2: 図2.9の説明
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ティアド・スイッチの追加

注: SCSはEL80-DTをサポートしていません。

スイッチを2レベルまでティア接続して( 図 2.10) 、ユーザーを最大512台のデバイ

スに接続できます。ティアド(階層形式)システムでは、メイン・スイッチの各デバイ

ス・ポートを、各ティアド・スイッチのACIポートに接続します。各ティアド・スイッチ

は、SIPまたはAvocent IQモジュールが接続されているデバイスに接続できます。

複数のスイッチをティア接続するには次の手順を実行します。

1 UTPケーブル(最長30メートル)の一方の端をスイッチのデバイス・ポートに取

り付けます。

2 UTPケーブルのもう一方の端を、ティアド・スイッチの背面にあるACIポートに

接続します。

3 ティアド・スイッチにデバイスを接続します。

4 システムに接続するすべてのティアド・スイッチに対して、この手順を繰り返し

ます。

注:システムが自動的に2つのスイッチを統合します。 ローカルUIのメイン・スイッチ
の一覧には、ティアド・スイッチに接続されているすべてのスイッチが表示されます。

注:スイッチは、メイン・スイッチのデバイス・ポートごとに1つのティアド・スイッチをサ
ポートしています。 ティアド・スイッチに、スイッチを接続することはできません。
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図2.10: UTPアナログ・スイッチとのSCSのティア接続
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番号 説明

1 ローカル・ユーザー

2 ARI接続

3 UTP接続

4 ACI接続( チェーン・アイコン)

表 2.3: 図2.10の説明

ティアド・レガシー・スイッチの追加

図2.11は、ティアド・レガシー・スイッチの接続を示します。

レガシー・スイッチ(オプション) を追加するには：

1 SCSをラックに収納します。 スイッチとレガシー・スイッチを接続するUTPケー

ブル(最長30メートル) を用意します。

2 UTPケーブルの一端をスイッチのARIポートに接続します。

3 UTPケーブルのもう一方の端をPS/2 SIPに接続します。

4 スイッチ・メーカーの推奨事項に従って、SIPをレガシー・スイッチに接続しま

す。

5 スイッチに取り付けるすべてのレガシー・スイッチで1～4の手順を繰り返しま

す。

注:プライマリSCSはARIポートまたはUSBポートごとに1つのスイッチのみをサポート
しています。 ティアド・スイッチに、スイッチをティア接続することはできません。
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図2.11:レガシー・スイッチのティア接続
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番号 説明

1 ローカル・ユーザー

2 ARI接続

3 SIP

4 PS2接続

5 ターゲット・デバイス接続

表 2.4: 図2.11の説明

ポート拡張モジュール(オプション)の追加

ポート拡張モジュール( PEM) により、各ARIポートを拡張して対応デバイス数を1

台から最大で8台にすることができます。図 2.12 およびその説明図を参照してくだ

さい。

注: PEMは受動的に作動します。 従って、PEMに接続されたデバイスのうちの1台に
ユーザーがアクセスすると、その後にこのPEMに接続されている他のデバイスのい
ずれかに他のユーザーがアクセスしようとしてもすべてブロックされます。

注: PEMを介してデバイスが接続されていると、バーチャル・メディア・セッションまた
はCACセッションは開始できません。

PEM( オプション) を追加するには次の手順を実行します。

1 PEMをラックに収納します。 UTPケーブルは9本まで使用できます。このうち

の1本はSCSをPEMに接続するために使用し、他の8本は各デバイスに接続さ

れているSIPにPEMを接続するために使用します。

2 PEMとSCSをつなぐUTPケーブル(最長30メートル)の一方の端を、PEM上の

他のコネクターからは若干離れた位置のRJ-45コネクターに接続します。

UTPケーブルのもう一方の端を、SCSの後面にある目的のARIポートに接続し

ます。

3 PEM背面に並んでいる8つのRJ-45コネクターのいずれか1つに、PEMと各デ

バイスに接続されているそれぞれのSIPをつなぐUTPケーブルを接続します。

4 UTPケーブルのもう一方の端を最初のSIPに接続します。
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5 接続したいデバイスのすべてで3と4の手順を繰り返します。

図2.12: PEMとのSCS構成

番号 説明

1 ARIポート

2 UTP

3 PEM

4 SIP

5 ターゲット・デバイス

表 2.5: 図2.12の説明
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SCSの構成
すべての物理接続が完了したら、SCSシステム全体で使用するためにSCSを構成

する必要があります。 この操作は、シリアル・インターフェイス、OBWI、OSCARま

たはAvocent管理ソフトウェアを使用して完了することができます。OSCARを使用

してSCSを構成するときは、「ネットワーク設定」( ページ71) を参照してくださ

い。Avocent管理ソフトウェアを使用するときは、Dell RAKが必要です。詳細につ

いては、該当するAvocent の「インストーラ／ユーザー・ガイド」を参照してくださ

い。

組み込みWebサーバーの設定
スイッチに関する日常作業の大部分については、OBWIを使用してSCSにアクセス

することができます。 OBWIを使用してSCSにアクセスする前に、ローカルUIを使

用しSCSの背面パネルにある10101セットアップ・ポートを介してIPアドレスを指定

します。SCS UIを使用するには、「ローカルOSCARユーザー・インターフェイス」(

ページ39) を参照してください。

ファイヤーウォールを使用したOBWIへの接続
アクセスにOBWIを使用するSCSのインストールでは、外部にアクセスする必要が

ある場合は、ファイヤーウォールで次のポートが開いている必要があります。

ポート番号 機能

TCP 80
ビデオ・ビューアの最初のダウンロードに使用されます。 SCS管理者はこ

の値を変更できます。

TCP 443
スイッチの管理とKVMセッションの起動を行うWebブラウザ・インターフェ

イスに使用されます。 SCS管理者はこの値を変更できます。

TCP 2068
スイッチでのKVMセッション・データ( マウスとキーボード ) の伝送またはビ

デオの伝送に使用されます( RAKが必要) 。

TCP/UDP 3211 検出( RAKが必要) 。

表 2.6: ファイヤーウォールでのOBWIポート
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次の図と表は代表的な構成を示します。この構成では、ユーザーのコンピュー

ターはファイヤーウォールの外側に位置し、スイッチはファイヤーウォールの内側

に位置します。

図2.13:代表的なSCSファイヤーウォールの構成

番号 説明

1 Server Console Switch.

2 ファイアウォール。

3 ユーザーのコンピューター。

4 ファイヤーウォールはHTTP要求とKVMトラフィックをスイッチへ転送します。

5 ユーザーがファイアウォール外側のIPアドレスを参照します。

表 2.7: 図 1の説明
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ファイヤーウォールを構成するには次の手順を実行します。

ファイアウォールの外側からスイッチにアクセスするには、ファイアウォールを構

成して、ファイアウォールの内部インターファイスを介してKVMスイッチに外部イン

ターフェイスからポート80および443が転送されるようにします。ファイヤーウォー

ルの特定ポートの転送手順については、マニュアルを参照してください。

注:管理者はポート80と443を再構成できます。 ポートの変更を有効にするには、再
起動する必要があります。

OBWIの起動の詳細については、「OBWIの操作」( ページ59) を参照してください。

電源状態の確認
スイッチの電源は1つです。スイッチに電源が入り正常に動作しているとき、LED

は緑に点灯します。

ターゲット・デバイスでのマウス設定の調整
スイッチに接続したコンピューターをリモート・ユーザー制御用に使用するには、

マウスの速度の設定を行い加速をオフにする必要があります。Microsoft ®

Windows®( Windows NT®、2000、XP、Server 2003) を稼動しているマシンでは、

デフォルトのUSBマウス・ドライバーを使用してください。

ローカル・マウスの動きとリモート・カーソルの表示の間で同期が保たれるよう

に、KVMスイッチを介してリモート・システムにアクセスするすべてのユーザー・ア

カウントでは、マウス加速度を「なし」に設定する必要があります。また、マウス加

速度は、各リモート・システムで「なし」に設定する必要があります。特殊なカーソ

ルは使用しないでください。また、カーソルの表示(ポインターの軌跡、Ctrlキーで

カーソルの位置表示、アニメーション、カーソルの影の有効、カーソルの非表示な

ど)のオプションもオフにしてください。

注: Windowsオペレーティング・システムからマウス加速度を無効にできない場合や、
すべてのターゲット・デバイスの設定を変更したくない場合は、「ビデオ・ビューア」ウ
ィンドウにある「Tools → Single Cursor Mode」コマンドを使用できます。 このコマンド
により、「ビデオ・ビューア」ウィンドウが「透明マウス」モードになります。これにより、
表示しているデバイス・システムのマウス・ポインターとクライアント・コンピューター
のマウス・ポインターとの間の制御を手動で切り替えることができます。
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ローカルOSCARユーザー・インター
フェイス

SCSにはユーザーサイドのキーボード／マウス・ポートがついており、アナログで

の直接アクセス用としてUSBのキーボードとマウスを接続することができます。

SCSではOSCARインターフェイスを使用して、システムとデバイスを構成すること

ができます。 OSCARインターフェイスを使用して、SCSに接続されているデバイス

にアクセスできます。

「Main」ダイアログ・ボックスの機能
OSCARインターフェイスのMainダイアログ・ボックスにアクセスするには：

Print Screenキーを押して、OSCARインターフェイスを起動します。Mainダイアロ

グ・ボックスが表示されます。

注: OSCARインターフェイスのパスワードが有効になっている場合は、パスワードの
入力を求めるメッセージが出され、入力した後にOSCARインターフェイスが起動しま
す。

ポートとデバイスの表示および選択

SCSシステム内のデバイスの表示、設定、制御は、OSCARのMainダイアログ・ボ

ックスで行います。デバイスは、名前、ポート、または各SIPモジュールに埋め込ま

れている個別のEID別に表示することができます。

次に示す図では、「Port」コラムにデバイスが接続されているARIポートが表示され

ています。 メインのSCSからスイッチをティア接続したために別の階層ができてい

る場合は、最初にスイッチのARIポートが一覧され、次にデバイスが接続されてい

るスイッチ・ポートが一覧されます。例えば、図 3.1では、06-01、06- 02、06-

03、06-04は接続されているデバイスです。ポート番号の一覧は、最初がARIポー
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ト番号を示し、その次がデバイスの接続されているスイッチ・ポートの名前になりま

す。PEMからスイッチをティア接続した場合も、EdieやGallowayの場合に示されて

いるように、単一のポートに複数のデバイスが表示されます。

図3.1: OSCARインターフェイスの「Main」ダイアログ・ボックス

注: Control、Alt、またはShiftキーを1秒以内に2度押して、OSCARインターフェイスを
起動させることもできます。 この章でPrint Screenに言及しているすべての箇所で、
このキー・シーケンスを代わりに使用できます。

ボタン 機能

Name デバイスの名前。

EID モジュール内の固有なEID。

Port デバイスが接続されているポート。

Clear オフラインのすべてのSIPをクリアする。

表 3.1: 「Main」ダイアログ・ボックスの機能
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ボタン 機能

Disconnect KVMセッションを接続解除する。

Setup
「Setup」ダイアログ・ボックスにアクセスして、OSCARインターフェイスを構成

する。

Commands 「Commands」ダイアログ・ボックスにアクセスする。

VMedia バーチャル・メディア接続をコントロールする。

スイッチ・システム・ステータスの表示

システム内のデバイス・ステータスは、Mainダイアログ・ボックスの右側コラムに

示されます。ステータス記号は以下のようになっています。

記

号
説明

( 緑の○) デバイスは接続中、電源オン状態、SIPはオンライン。

接続されているデバイスの電源が入っていないか、正しく作動しておらず、SIPはオ

フライン。

接続されたスイッチはオンライン。

接続スイッチはオフラインであるか、または正しく作動していない。

( 黄色の○) 該当するSIPは現在アップグレード中。 このマークの表示中は、スイッ

チや接続デバイスのパワーサイクリング( 電源を一旦切って入れ直す) を行わない

こと。またSIPの接続も解除しないこと。 これを行った場合、モジュールが恒久的に

作動不能になりSIPに工場返送、修理の必要が生じることがあります。

( 緑の文字) SIPは表示されているユーザー・チャンネルによって現在アクセスされて

いる。

( 黒の文字) SIPは表示されているユーザー・チャンネルによってブロックされている。

表 3.2: OSDインターフェイスのステータスを表す記号
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デバイスの選択

Mainダイアログ・ボックスを使用してデバイスを選択します。デバイスを選択する

と、スイッチはこのデバイスに合わせてローカルのキーボードとマウスを再設定し

ます。

デバイスを選択するには：

デバイス名、EID、またはポート番号をダブルクリックします。

-または-

リストの表示順がポート別になっている場合( Portボタンが押された状態) は、

ポート番号を入力してEnterキーを押します。

-または-

リストの表示順が名前別またはEID別になっている場合( 「Name」または「EID」ボ

タンが押された状態)は、デバイスの名前あるいはEID番号の最初の数文字を入

力し、Enterキーを押します。

以前接続したデバイスを選択するには：

Print Screenキーを押してからBackspaceキーを押します。このキー操作は、以前

の接続と現在の接続を切り替えるトグルスイッチとして働きます。

デバイスを接続解除するには：

Print Screenキーを押してからAlt+0( ゼロ)キーを押します。このキー操作によ

り、該当のユーザーはデバイスを選択していない自由な状態になります。デスクト
ップのステータス・フラグにはFreeが表示されます。

ソフト・スイッチング

ソフト・スイッチングとは、ホット・キー・シーケンスを使用してデバイスを切り替え

ることを指します。Print Screenキーを押してからデバイスの名前または番号の最

初の数文字を入力すると、選択した方法によって、ソフト・スイッチによりデバイス

を切り替えることができます。OSCARインターフェイスの「Screen Delay Time」を

設定している場合は、その遅延時間が経過するまで、キー・シーケンスを押して

もOSCARインターフェイスは表示されません。
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デバイスにソフト・スイッチで切り替えるには：

Print Screenキーを押して、ポート番号または固有のターゲット・デバイス名の最

初の数文字を入力し、Enterキーを押します。

以前のデバイスに戻るには、Print Screenキーを押してからBackspaceキーを押し

ます。

OSCARインターフェイスの操作

次の表は、キーボードとマウスを使用するOSCARインターフェイスの操作方法の

説明です。

キーストローク 機能

Print
Screen、Ctrl+Ctrl、Shift+Shift
および／またはAlt+Altキー

OSCARインターフェイスを起動させるためのシーケンス。 デフォルト設

定では、Print ScreenキーおよびCtrl-CtrlキーがOSCARインターフェイス

起動のオプションとなっています。 使用する前に、Shift+Shiftキーおよ

びAlt+AltキーがOSCARインターフェイス内で設定されている必要があり

ます。

F1キー 現在のダイアログ・ボックスのヘルプ画面を開きます。

Escapeキー

変更内容を保存せずに現在のダイアログ・ボックスを閉じて、元のダ

イアログ・ボックスに戻ります。 「Main」ダイアログ・ボックスが表示され

ている場合、Escapeキーを押すとOSCARインターフェイスが閉じ、ス

テータス・フラグが表示されます( ステータス・フラグが有効になっている

場合) 。詳細については、「「Commands」ダイアログ・ボックスの機

能」(ページ52) を参照してください。メッセージ・ボックスの場合

は、Escapeキーを押してポップ・アップ・ボックスを終了し、現在のダイ

アログ・ボックスに戻ります。

Altキー

ダイアログ・ボックスを開き、オプション項目を選択します。下線付き

の文字や他の指定文字と共に使用する場合は、特定の操作が実

行できます。

表 3.3: OSCARインターフェイスの操作に関する基本事項
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キーストローク 機能

Alt+Xキー
現在のダイアログ・ボックスを閉じ、元のダイアログ・ボックスに戻りま

す。

Alt+Oキー OKボタンを選択し、元のダイアログ・ボックスに戻ります。

Enterキー
「 Main」ダイアログ・ボックスのスイッチ操作を完了し、OSCARインター

フェイスを終了します。

シングルクリック、Enterキー

テキスト・ボックス内で、入力項目をシングルクリックしてEnterキーを押

し、編集するテキスト ( 文字列) を選択し、左および右矢印キーによ

るカーソルの移動を可能にします。 Enterキーをもう一度押すと、「編

集」モードが終了します。

Print Screen、Backspace
キー

以前の選択事項に戻ります。

Print Screen、Pauseキー
直ちに「Screen Saver」モードになり、パスワード保護されている場合

はこのコンソールヘのアクセスはできなくなります。

上／下向き矢印キー 一覧内でカーソルを上下に一行ずつ移動させます。

右／左向き矢印キー
カーソルをコラム間で移動させます。 テキスト・ボックス編集中の場

合、カーソルはコラム内で移動します。

Page Up/Page Downキー
「Name」リスト、「Port」リスト、および「Help」ページ内で上下にスク

ロールします。

Home/Endキー リストの一番上または一番下までカーソルを移動させます。

バックスペース・キー テキスト・ボックス内の文字を削除します。

ローカル・バーチャル・メディアの接続

スイッチのUSBポートを使用してバーチャル・メディアをスイッチに直接接続するこ

とができます。
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注:すべてのUSBポートは単一のバーチャル・メディア・セッションに割り当てられて
おり、個別にマップすることはできません。

ローカル・バーチャル・メディア・セッションを開始するには、以下の手順を行いま

す：

1 Print Screenキーを押しOSCARインターフェイスを起動して、「Main」ウィンド

ウを開きます。

2 バーチャル・メディア・セッションを確立するデバイスにユーザーを接続しま

す。

3 矢印キーを使用してデバイス名を反転表示にし、Enterキーを押します。

4 Print Screenキーを押して、再度OSCARインターフェイスを起動します。

「Virtual Media」ウィンドウが表示されます。

5 次のチェックボックスから１つまたは複数を選択します：

• Locked - このチェックボックスをオンにするとユーザーがデバイスから接

続解除されたときに、バーチャル・メディアも接続解除されるようになりま

す。

• Reserve - このチェックボックスをオンにすると、バーチャル・メディア接

続はユーザー名によってのみアクセスできるようになり、他のユーザー

は当該デバイスに接続できなくなります。 「Locked」と「Reserve」の両方

が選択されている場合、セッションは予約された状態になります。

• CD ROM - このチェックボックスをオンにすると、デバイスに対するバー

チャル・メディアCDの接続が確立されます。 チェックボックスをオフにす

ると、接続が解除されます。

• Mass Storage - このチェックボックスをオンにすると、デバイスに対する

バーチャル・メディア大容量記憶装置の接続が確立されます。チェックボ

ックスをオフにすると、接続が解除されます。

• Write Access - このチェックボックスをオンにすると、バーチャル・メディ

ア・セッション中、接続されたデバイスでバーチャル・メディアへのデータ

書き込みが可能になります。 読み込みアクセスはバーチャル・メディア・

セッション中常時可能です。

6. OKをクリックします。
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「Setup」ダイアログ・ボックスの機能
OSCARインターフェイス内のSetupダイアログ・ボックスからSCSを設定することが

できます。SCSを初めてセットアップする際は、Namesボタンをクリックして、固有

名により特定のデバイスを指定します。デバイスに対して定期的なタスクを実行す

るには、OSCARインターフェイス・メニューから他のセットアップ機能を選択しま

す。次の表は、「Setup」ダイアログ・ボックスに含まれる各ボタンを使用してアクセ

スされる機能を一覧しています。

OSCARインターフェイスのSetupダイアログ・ボックスにアクセスするには、Mainダ

イアログ・ボックスでSetupをクリックします。

機能 目的

Menu

ポート番号別、EID番号で数字順の場合と名前別でアルファベット順の場

合とに「Main」ダイアログ・ボックス一覧の並び替えオプションを切り換えま

す。 Print Screenキーを押してからOSCARインターフェイスが表示されるまで

の「Screen Delay Time」を変更します。 また、OSCARインターフェイス起動

シーケンスの呼び出し方法を変更することもできます。

Security
アクセス権を保護または制限するパスワードを設定したり、スクリーン・セー

バーを有効にします。

Devices 接続されているティアド・スイッチでの適切なポート数を確認します。

Names 固有名でデバイスを識別します。

Keyboard USBデバイス用のキーボード・コード値を設定します。

Broadcast
キーボードおよびマウスの操作で複数のデバイスを同時に制御できるようセ

ットアップします。

Switch
スイッチによるローカル・ポート接続の管理方法を変更します。 「Local」制
御から「Local Share Mode」へ。

Network ネットワークの速度、送信モード、設定を選択します。

表 3.4: 「Setup」ダイアログ・ボックスの機能
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機能 目的

Scan 複数のデバイスに対するスキャンのカスタマイズ・パターンを設定します。

VMedia バーチャル・メディア・セッション中のスイッチの動作を設定します。

表示動作の変更

Menuダイアログ・ボッ クスを使用して、表示される デバイスの順序の変

更、OSCARインターフェイスの起動方法の変更、OSCARインターフェース用

の「Screen Delay Time」の設定ができます。この設定により、デバイスの表示

が、Main、Devices、Scanなどいくつかのダイアログ・ボックス画面で変更されま

す。

OSCARイン ターフ ェイスのMenu ダイアログ・ ボッ クスにアクセスする に

は、OSCARインターフェイスを起動にして、Mainダイアログ・ボックスでSetup →

Menuを順にクリックします。

デバイスの表示順序を選択するには：

1 デバイスを名前別でアルファベット順に表示するにはNameを選択します。

-または-

デバイスをEID番号順に表示するにはEIDを選択します。

-または-

デバイスをポート番号順に表示するにはPortを選択します。

2 OKをクリックします。

選択した表示方法によって、対応するボタンがMainダイアログ・ボックスで押し込

まれた状態になります。

OSCARインターフェイスの起動方法を変更するには：

1 一覧されている方法の隣にあるチェックボックスを選択します。

2 OKをクリックします。
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OSCARインターフェイスの「Screen Delay Time」を設定するには：

1 Print Screenキーを押した後で、OSCARインターフェイスの表示を遅らせる秒

数( 0～9) を入力します。 0を入力すると、遅延なしでOSCARインターフェイス

が起動します。

2 OKをクリックします。

「Screen Delay Time」を設定すると、OSCARインターフェイスを使用しないでソフ

ト・スイッチを完了できるようになります。ソフト・スイッチの実行については、「ソフ

ト・スイッチング」( ページ42) を参照してください。

ステータス・フラグの制御

デスクトップのステータス・フラグには、指定デバイスの名前やEID番号、または指

定ポートのステータスが表示されます。Flagダイアログ・ボックスでは、デバイス名

やEID番号別のフラグ表示の設定や、フラグの色、不透明度、表示時間、デスクト

ップ上の位置などの変更ができます。

OSCARインターフェイスのFlagダイアログ・ボックスにアクセスするには：

OSCARインターフェイスを有効にし、Setup → Flagを順にクリックしてFlagダイアロ

グ・ボックスを開きます。

ステータス・フラグの表示形態を指定するには：

1 NameまたはEIDを選択して、いずれの情報を表示するかを決めます。OSCAR

インターフェイスの次のステータス・フラグが使用できます。

• フラグの説明

• 名前別でのフラグ表示

• EID番号によるフラグ表示

• ユーザーがすべてのシステムから接続解除されていることを示すフラグ

2 Displayedを選択してフラグ表示を有効にします。切替後、フラグはユーザー

が他のデバイスに切り替えるまで画面にそのままの状態で残ります。Timed

を選択すると、切替が行われたときに5秒間だけフラグが表示され、その後は

表示されなくなります。
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3 「Display Color」でフラグの色を選択します。フラグの色には次の種類があり

ます：

• フラグ 1 - フラグは灰色、文字列は黒

• フラグ 2 - フラグは白、文字列は赤

• フラグ 3 - フラグは白、文字列は青

• フラグ 4 - フラグは白、文字列は紫

4 「Display Mode」で、Opaqueを選択するとフラグが無色になり、Transparent を

選択するとフラグを通してデスクトップが見えるようになります。

5 デスクトップ上でステータス・フラグの位置を決めるには：

a. Set Positionをクリックして、「フラグの位置設定」画面にアクセスします。

b. マウスでタイトル・バーを左クリックし、希望する位置までドラッグします。

c. マウスで右クリックすると、Flagダイアログ・ボックスに戻ります。

注: フラグ位置の変更は、「Flag」ダイアログ・ボックスでOK をクリックするまでは保存
されません。

6 OKをクリックして設定内容を保存します。

-または-

Xをクリックして変更内容を保存せずに終了します。

キーボードの国コードの設定

注:スイッチのファームウェアの言語と異なる言語に対応のキーボード・コードを使用
すると、キーボード・マッピングに支障をきたします。

デフォルト設定では、このスイッチはデバイスに取り付けられたUSBケーブルに米

国のキーボード・コードを送信するようになっています。このコードは、該当デバイ

スがオンになった時点、または再起動された時点で適用されます。 コードはこの

後、SIPに保存されます。キーボード・コードが米国に設定されているのに別の国

用のキーボードを使用している場合には、問題が起こることがあります。

例えば、米国用キーボードの「Z」キーの位置は、ドイツ用キーボードの「Y」のキー

の位置と同じになっています。Keyboardダイアログ・ボックスを使用すれば、デフ
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ォルトとして設定されている米国用のキーボード・コードを別の国のコードに変更

することができます。変更を行うと、デバイスをオンにした時点、あるいは再起動し

た時点でSCSに接続されているデバイスすべてに変更内容が送信され、新しい

キーボード・コードはSIPに保存されます。

注: SIPを別のデバイスに移した場合は、キーボードの国コードはリセットしなければ
なりません。

デバイスの種類の割当

OSCARインターフェイスのDevicesダイアログ・ボックスにアクセスするには：

OSCARインターフェイスを有効にし、Setup → Devicesを順にクリックしてDevices

ダイアログ・ボックスを開きます。

注: 「Modify」ボタンが使用できるのは設定可能なスイッチが選択されている場合の
みです。

スイッチがティアド・スイッチを検出すると、そのスイッチ下の各デバイスに合わせ

て番号形式がSCSポートから [SCS port]-[スイッチ・ポート]に変わります。

例えば、SCSポート6にスイッチが接続されている場合、このスイッチへ接続されて

いる各デバイスには順番に番号が付けられます。 SCSポート6のスイッチ・ポー

ト1を使用するデバイスは06-01、SCSポート6のスイッチ・ポート2を使用するデバ

イスであれば06-02、といった具合です。

デバイスの種類を割り当てるには：

1 Devicesダイアログ・ボックスで、希望するポート番号を選択します。

2 Modifyをクリックして、Device Modifyダイアログ・ボックスを開きます。

3 使用のスイッチでサポートされるポートの数を選び、OKをクリックします。

4 デバイスの種類を割り当てる必要のある全ポートに関して手順1～3を繰り返

します。

デバイス名の割当

デバイスをポート番号別ではなく名前別で認識するよう設定するにはNamesダイ

アログ・ボックスを使用します。Namesリストは常にポート順に並べられます。
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各SIPの名前またはEID番号表示の間で切替が可能であるため、SIP／デバイスを

ほかのポートに移動しても、名前と構成はスイッチによって認識されます。

注:デバイスは初めて接続されたときは、電源がオンになるまで名前リストに表示さ
れません。 一度初期接続が行われると、電源をオフにした場合でも名前リストに表
示されるようになります。

OSCARインターフェイスのNamesダイアログ・ボックスに アクセスする に

は、OSCARインターフェイスを有効にして、Setup →Namesを順にクリックします。

注:スイッチによって新しいSIPが検出された場合は、画面上のリストも自動的に更新
されます。 更新中は、マウス・カーソルの代わりに砂時計が表示されます。 リストの
更新が完了するまでは、マウスとキーボードのいずれからも入力はできません。

デバイスに名前を割り当てるには：

1 Namesダイアログ・ボックスで、デバイスの名前またはポート番号を選択

し、Modifyをクリックして、Name Modifyダイアログ・ボックスを開きます。

2 New Nameのボックスに名前を入力します。デバイスの名前には、印刷可能な

文字はすべて含めることができます。

3 OKをクリックして新しい名前を割り当てます。

4 システムの各デバイスで手順1～3を繰り返します。

5 Namesダイアログ・ボックスでOKをクリックして変更内容を保存します。

-または-

Xをクリックするか、Escapeを押して、変更内容を保存せずにダイアログ・

ボックスを終了します。

ネットワーク設定の構成

Networkダイアログ・ボックスを使用して、ネットワーク速度、伝送モード、および

ネットワーク構成の機能を設定します。

ネットワーク設定を変更するには：

1 OSCARインターフェイスが開いていない場合は、Print Screenキーを押し

てMainダイアログ・ボックスを開きます。
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2 Setup →Networkを順にクリックしてNetworkダイアログ・ボックスを開きま

す。

3 希望する変更を行ったら、OKをクリックして確定するか、Xをクリックして変更

せずに終了します。

注:ネットワーク設定を変更すると、スイッチの再起動が必要となります。

4 Devicesダイアログ・ボックスでOKをクリックし、設定内容を保存します。

注: 「Device Modify」ダイアログ・ボックスで入力した変更内容は、「Devices」ダイアロ
グ・ボックスでOKをクリックするまでは保存されません。

注: 「Name Modify」ダイアログ・ボックスで入力した変更内容は、「Names」ダイアロ
グ・ボックスでOKをクリックするまでは保存されません。

注: SIPに名前が割り当てられていない場合にはEIDがデフォルト名として使用されま
す。

「Commands」ダイアログ・ボックスの機能
OSCARインターフェイスのCommandsダイアログ・ボックスでは、スイッチ・システ

ムやユーザー接続の管理、スキャン・モードの有効化、ファームウェアの更新など

を行うことができます。

機能 目的

Scan Enable

デバイスのスキャンを開始します。 「Setup」ダイアロ

グ・ボックスで、スキャン用のデバイスのリストを設定し

ます。デバイス・スキャンを有効にするには、少なくと

も「Setup」 → 「Scan」のリスト・メニューで2台のデバ

イスを選択している必要があります。

User Status ユーザーの表示および接続解除を行います。

SIP Status
SIPのタイプごとに現在利用できるファームウェアが表

示されます。

表 3.5: デバイスの定期なタスクを管理するためのコマンド



ローカルOSCARユーザー・インターフェイスxxx | xxx53

機能 目的

Display Versions
スイッチのバージョン情報の表示、また個々のSIPのフ

ァームウェアの表示やアップグレードを行います。

Display Config 現在の環境設定パラメーターを表示します。

Device Reset
ローカル・ポートのキーボードとマウスの作動を再確

立します。

OSCARインターフェイスのCommandsダイアログ・ボックスにアクセスするには：

OSCARインターフェイスを有効にし、Commandsをクリックして、ダイアログ・ボック

スを開きます。

スキャン・モードのデバイスの選択

Scanダイアログ・ボックスでは、ローカル・ユーザーがスキャン・モード中に含める

デバイスのカスタム・リストや各デバイスを表示する秒数を定義することができま

す。スキャン・リストを作成しても、スキャン・モードは起動しません。Commandsダ

イアログ・ボックのScan Enableを介してスキャン・モードを有効にする必要があり

ます。スキャン・リストは、Menuダイアログ・ボックスで設定された形式で表示され

ます。Scanダイアログ・ボックスでボタンを1つ選んで、名前、EIDまたはポートの

いずれかで並び替えるように変更することができます。リストのデバイスが利用で

きないときは、スキップされます。閲覧モードでは、競合するネットワーク・ユー

ザーが当該デバイスへのパスをブロックしていない限り、デバイスが表示されま

す。閲覧モードで競合が検出された場合( またはデバイスが利用できない場合) 、

表示されるはずのデバイスはスキップされます。

スキャン・リストにデバイスを追加するには：

1 OSCARインターフェイスを有効にし、Setup →Scanを順にクリックしてScanダ

イアログ・ボックスを開きます。

2 ダイアログ・ボックスには、スイッチに接続されているすべてのデバイスの一

覧が含まれます。デバイスの右側についているチェックボックスをクリックし

て、希望する入力項目をダブルクリックする、またはデバイスを強調表示

し、Add/Removeボタンをクリックして、Scanチェックボックスの設定を切り替
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えます。スキャン・リストに含めるデバイスを最大100台まで選択することがで

きます。

注: Clearボタンをクリックし、スキャン・リストからすべてのデバイスを削除します。

3 「Time」フィールドに、スキャン中に各デバイスを表示する秒数を( 3～255) の

範囲で入力します。デフォルト値は、デバイス1台につき15秒です。

4 OKをクリックします。

注: Scanダイアログ・ボックスに表示されるデバイスの順序は、デバイスが選択され
た順序に基づいています。ループ時に単一デバイスの複数回のスキャンはサポート
されていません。スキャン時間は、すべてのデバイスで同一でなければなりませ
ん。

スキャン・モードの有効化／無効化

スキャン・モードを開始するには：

1 OSCARインターフェイスを有効にして、Commandsをクリックしま

す。Commandsダイアログ・ボックスが表示されます。

2 Commandsダイアログ・ボックスでScan Enableを選択します。スキャンが開始

されます。

3 Xをクリックし、Commandsダイアログ・ボックスを閉じます。

スキャン・モードをキャンセルするには：

OSCARインターフェイスが開いていれば、デバイスを選択します。

-または-

OSCARインターフェイスが開いていない場合は、マウスを移動するか、キーボー

ド上の任意のキーを押します。 スキャンは現在選択されているデバイスで停止し

ます。

-または-

Commandsダイアログ・ボックスでScan Enableチェック・ボックスのチェック印を外

します。
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ユーザー接続の表示／解除

User Statusダイアログ・ボックスを使ってユーザーを表示したり、接続解除したり

することができます。ユーザー名( U) とサーバー( S) は、デバイスに接続されてい

るとき( ローカルまたはリモート)は常時表示されます。ユーザーが接続されている

デバイス名またはEID番号のいずれかを表示できます。現在チャンネルに接続さ

れているユーザーがいない場合は、ユーザー名およびデバイスのフィールドは空

欄になります。

現在のユーザー接続を表示する には、OSCARイン ターフェイスを有効に

し、Commands→User Statusを順にクリックして、User Statusダイアログ・ボック

スを開きます。

ユーザーの接続を解除するには：

1 User Statusダイアログ・ボックスで、接続を解除するユーザーに対応する文

字をクリックします。Disconnectダイアログ・ボックスが表示されます。

2 Disconnectをクリックしてそのユーザーの接続を解除し、User Statusダイアロ

グ・ボックスに戻ります。

-または-

Xをクリックするか、Escapeキーを押して、ユーザーの接続を解除せずに

ダイアログ・ボックスを終了します。

バージョン情報の表示およびファームウェアのアップグレード

トラブルシューティングやサポートの際に、OSCARインターフェイスでスイッチのフ

ァームウェアとスイッチの接続されている補助デバイスのバージョン番号を表示し

たり、さらに最適な性能を得るためにファームウェアをアップグレードすることもで

きます。

バージョン情報を表示したり、ファームウェアをアップグレードするには：

1 OSCARインターフェイスを有効にして、Commands →Display Versionsを順に

クリックします。ボックスの上半分に、スイッチのサブシステムのバージョンが

一覧表示され、下半分に、現在のIPアドレス、マスク、MACおよびEIDが表示さ

れます。
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2 ファームウェアのアップグレードを希望する場合は、Upgradeをクリックしてか

ら、OKをクリックしダウンロード・ボックスを開きます。FTPまたはTFTPデバイ

スのIPアドレスと関連する情報を求めるメッセージが表示されます。

3 Downloadをクリックします。ファームウェアがダウンロードされた後

に、Upgradeダイアログ・ボックスが表示されます。

4 Upgradeボタンをクリックします。

注:アップグレードが完了するとスイッチは再起動します。

SIPを個別にアップグレードするには：

1 各SIPモジュールのバージョン情報を表示するには、SIPボタンをクリックしま

す。

2 SIPボタンを選択して表示し、Versionボタンをクリックします。

3 Load Firmwareボタンをクリックします。

4 OKをクリックするとアップグレードが開始され、Statusダイアログ・ボックスに

戻ります。

注:アップグレード中は、Mainダイアログ・ボックスのSIPステータス・インジケータは
黄色表示になります。 SIPはアップグレード中には使用できなくなります。 アップグ
レードが開始されると、SIPを介して確立されていたデバイスへの接続はすべて解除
されます。

複数のSIPを同時にアップグレードするには：

1 OSCARインターフェイスを有効にして、Commands →SIP Statusを順にクリッ

クし、アップグレードするSIPの1つまたは複数のタイプをクリックします。

2 Upgradeをクリックします。

注: 「SIP Status」ダイアログ・ボックス内の「Enable SIP Auto update」オプションが有
効になっている場合には、スイッチ・ファームウェアがアップグレードされる段階で、
あるいはファームウェア・アップグレード後にスイッチが新しいSIPを検出した段階
で、SIPのファームウェアは自動的にアップグレードされます。 検出されていても、フ
ァームウェア・アップグレード中にスイッチに接続されていないSIPモジュールに関し
ては、手動でアップグレードしてください。

3 Upgradeダイアログ・ボックスが表示されます。OKをクリックするとアップグ

レードが開始し、SIP Statusダイアログ・ボックスに戻ります。
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SIPを工場出荷時のデフォルト・ステータスに戻すには：

1 Versionダイアログ・ボックスでSIPをクリックします。

2 SIPを選択して、次にDecommissionをクリックします。

3 OKをクリックして工場出荷時のデフォルト設定に復元します。SIPが短時間オ

フラインになったあと、元に戻るのが分かります。

-または-

X クリックするか、Escapeキーを押して操作をキャンセルします。

4 Xをクリックし、SIP Selectダイアログ・ボックスを閉じます。
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OBWIの操作

SCSのOBWIは、リモートのWebブラウザ・ベースのユーザー・インターフェイスで

す。システム・セットアップの詳細については、「SCSハードウェアの接続」( ペー

ジ23) を参照してください。次の表に、OBWIでサポートされているオペレーティン

グ・システムとブラウザの一覧を示します。必ず最新バージョンのWebブラウザを

使用してください。

オペレーティング・システム

ブラウザ

Microsoft® Internet
Explorerバージョン6.0
SP1以降

Firefoxバージョン2.0以降

Microsoft Windows 2000
Workstationまた

はServer( Service Pack 2)
はい はい

Microsoft Windows
Server® 2003
Standard、Enterpriseまた

はWeb Edition

はい はい

Microsoft Windows
Server® 2008
Standard、Enterpriseまた

はWeb Edition

はい はい

表 4.1: OBWIでサポートされているオペレーティング・システム
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オペレーティング・システム

ブラウザ

Microsoft® Internet
Explorerバージョン6.0
SP1以降

Firefoxバージョン2.0以降

Windows XP
Professional( Service Pack
3)

はい はい

Windows Vista®

Business( Service Pack 1)
はい はい

Red Hat Enterprise Linux®

4および5
Standard、Enterpriseまた

はWeb Edition( スマート・

カードはオペレーティング・

システムでサポートされて

いない場合があります)

いいえ はい

Sun Solaris® 9および10( ス
マート・カードはオペレーテ

ィング・システムでサポート

されていない場合がありま

す)

いいえ はい

Novell SUSE Linux
Enterprise 10および11( ス
マート・カードはオペレーテ

ィング・システムでサポート

されていない場合がありま

す)

いいえ はい
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オペレーティング・システム

ブラウザ

Microsoft® Internet
Explorerバージョン6.0
SP1以降

Firefoxバージョン2.0以降

Ubuntu 8 Workstation( ス
マート・カードはオペレーテ

ィング・システムでサポート

されていない場合がありま

す)

いいえ はい

SCSのOBWIにログインするには：

1 Webブラウザを起動します。

2 ブラウザのアドレス欄に、アクセスするスイッチに割り当てられているIPアドレ

スまたはホスト名を入力します。 「https://xxx.xx.xx.xx」または「https://ホス

ト名」の形式を使用します。

注: IPv6モードを使用している場合は、IPアドレスを角括弧で囲む必要があります。
「https://[<ipaddress-] 」の形式を使用します。

3 ブラウザがスイッチに接続されたらユーザー名とパスワードを入力し、Loginを

クリックします。スイッチのOBWIが表示されます。

注:デフォルトのユーザー名はAdminです。パスワードは必要ありません。

ファイヤーウォールの外側からスイッチのOBWIにログインするには、上記の手順

を繰り返し、代わりにファイヤーウォールの外部IPアドレスを入力します。

注: SCSは、お使いのコンピューターにJavaがすでにインストールされているかどう
か、検出を試みます。 インストールされていない場合、OBWIを使用するにはインス
トールが必要です。 また、JNLPファイルをJava WebStartに関連付ける必要もありま
す。

注: OBWIを使用するには、Java Runtime Environment( JRE)バージョン1.6.0_11以降
が必要です。

注: OBWIにいったんログインすると、ログアウトするか、セッションのアイドル時間が
管理者指定のタイムアウトを超過した場合を除いて、新規セッションを起動する際に
ログインし直す必要はありません。
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OBWIの使用
認証後に、ユーザー・インターフェイスが表示されます。 ここでは、スイッチの表

示、アクセス、管理を行ったり、システム設定の指定とプロファイル設定の変更を

行うことができます。ユーザー・インターフェイス・ウィンドウの領域は図4.1のよう

になっています。画面の説明を、図に続く表に示します。

図4.1: OBWIウィンドウ

番号 説明

1
トップ・オプション・バー：トップ・オプション・バーを使用して、テクニカル・サ

ポートに連絡したり、ソフトウェアの一般情報を表示したり、OBWIセッション

からログアウトしたりします。

表 4.2: 図4.1の説明
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番号 説明

2
2番目のオプション・バー：このバーを使用して、Webページを印刷したり、現

在のWebページを更新したり、ヘルプ・ツールにアクセスしたりします。

3
バージョン・ブロック：製品のファームウェアのバージョンと現在ログインしてい

るユーザー名が、トップ・オプション・バーの左側に表示されます。

4
サイド・ナビゲーション・バー：サイド・ナビゲーション・バーを使用して、表示

する情報を選択します。サイド・ナビゲーション・バーでは、設定の変更や

操作を実行するためのウィンドウを表示できます。

5
ナビゲーション・タブ：選択したタブのコンテンツ領域にシステム情報が表示

されます。一部のタブにはサブタブがあり、クリックして表示し、カテゴリー内

の詳細を変更できます。

6
コンテンツ領域：コンテンツ領域を使用して、スイッチのOBWIシステムを表

示したり、変更したりできます。

システム情報の表示
ユーザー・インターファイスの以下の画面では、スイッチおよびターゲット・デバイ

スの情報を表示することができます。

カテゴリー
操作画面の選択順

表示内容

ターゲット・

デバイス

Unit View - Target
Devices

接続されているデバイスの一覧、ならびに、名前、

タイプ、状態、および各デバイスの操作。

以下の情報を表示するには、ターゲット・デバイス

をクリックします：名前、タイプ、EID、使用できるセ

ッション・オプションおよび接続パス。

表 4.3: システム情報
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カテゴリー
操作画面の選択順

表示内容

SCS
Unit View - SCS -
Tools

名前、タイプ、スイッチ・ツール( メンテナンス - 概
要／再起動／リセットおよびアップグレード、証明

書およびトラップMIB) 。

Unit View - SCS -
Files

スイッチの構成とユーザー・データベース。

Unit View - SCS -
Properties - Identity

部品番号、シリアル番号、およびDell RAKのス

テータス(デフォルト設定では無効) 。

Unit View - SCS -
Properties - Location

各ユニットのサイト、部門およびロケーション。

Unit View - SCS
Settings - Versions

現行アプリケーション、ブート、ビルド、ハードウェ

ア、UART、ビデオASICのバージョン。

Unit View - SCS
Settings - Network

ネットワーク・アドレス、LAN速度、およびWebサー

バー・ポート。

Unit View - SCS
Settings - SNMP

システム説明、SNMP設定、連絡先、読み取り／

書き込みおよびトラップ設定、および許可されたマ

ネージャー用の送信先。

Unit View - SCS
Settings - Auditing

イベント一覧と状態およびSNMPトラップ送信先。

Unit View - SCS
Settings - Ports

各SIPの状態、EID、名前、ポート、アプリケーショ

ンとインターフェイス・タイプ；各ティアド・スイッチの

名前、ポート、タイプ、チャンネル、および状態。

Unit View - SCS
Settings Sessions

一般セッション・タイムアウトおよび共有詳

細；KVM暗号化レベルおよびキーボード言語；

バーチャル・メディア、ドライブ・マッピング、暗号レ

ベル、SIPアクセス。
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カテゴリー
操作画面の選択順

表示内容

Unit View - SCS -
User Accounts

ローカル・アカウント用のセキュリティおよびユーザー

監視；Avocent管理ソフトウェアの認証サーバー割

り当て、操作に失敗した場合の上書き管理者の

ユーザー名とパスワード。

Unit View - SCS -
Connections

接続パス名とタイプ。

アクティブ・セッション
各アクティブ・セッションのサーバー、所有者、リ

モート・ホスト、継続時間、タイプ。

スキャン・モード
注:スキャン・モードは、Dell RAKがインストールされているときにサポートされます。

スキャン・モードでは、スイッチにより複数のターゲット・デバイスがスキャンされま

す。スキャンは、一覧内でターゲット・デバイスが表示されている順序に従って実

行されます。 また、スキャンが一覧の次のターゲット・デバイスに移動するまでの

時間を設定できます。

スキャン・リストにターゲット・デバイスを追加するには

1 サイド・ナビゲーション・バーから、Unit View →Target Devicesの順に選択し

て、「Target Devices」画面を開きます。

2 スキャンするターゲット・デバイスの横にあるチェックボックスをオンにしま

す。

3 Scanをクリックします。

証明書の生成
Web証明書によって、OBWIにアクセスするたびにSCSを信頼できるWebデバイス

として確認してもらう必要なしにアクセスすることができます。 「Install Web

Certificate」ウィンドウを使用すると、新しい自己署名のOpenSSL証明書を生成し

たり、証明書をアップロードしたりすることができます。アップロードされる証明書
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は、非暗号化のプライベート・キーを持つOpenSSL PEM形式になっていなければ

なりません。

Web証明書をインストールするには：

1 OBWIでToolsタブをクリックします。

2 Upgradeボタンをクリックします。

3 Generate a new Self-Signed Certificateオプション・ボタンを選択して、次のフ

ィールドに入力します：

• Common Name: 自社の名称。( 貴社のルート 証明書であ る の

で、「Company_Name Certificate Authority」などのように適した名称を使

用してください) 。

• Organization: 組織単位名( 「marketing」など) 。

• City or Locality: 貴社の所在地の市名。

• State or Province: 所属組織の所在する都道府県の略称。

• Country: 国のISO略称( 2文字) 。

• Email Address: 証明機関( CA) 連絡用の電子メール・アドレス。

4 Generateをクリックして証明書を作成します。

新しい証明書をアップロードするには：

1 Upload a New Certificateオプション・ボタンをクリックします。

2 方法( Filesystem、TFTP、FTPまたはHTTP) を選択します。

3 Browseをクリックして、証明書を検索するか、証明書のファイル名を入力しま

す。

4 Installを選択します。Webブラウザを閉じて、OBWIを同一IPアドレスでもう一度

起動します。

注:会社の証明書ファイルのインポートでは、OBWIを起動するのに最高30秒かかる
場合があります。

5 プロンプトが表示されたら証明書を参照するためのオプションをクリックし、画

面の指示に従って証明書をRoot Certificate Authorityフォルダにインポートし
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ます。証明書が保存されたあとは、証明書に関する警告メッセージは表示さ

れなくなるはずです。

ツール － 再起動およびアップグレード
「Tools → Maintenance →Overview」画面では、スイッチ名とタイプを表示できま

す。また、以下のタスクを実行することができます。

SCSの再起動

SCSを再起動するには次の手順を実行します。

1 サイド・ ナ ビゲーション・バーから、Unit View → SCS → Tools →

Maintenance →Overviewのタブの順に選択して、「Unit Maintenance」画面を

開きます。

2 Rebootボタンをクリックします。

3 ダイアログ・ボックスが表示され、すべてのアクティブ・セッションの接続が解

除されることを警告します。OKボタンをクリックします。

注:ローカルUIを使用している場合、スイッチの再起動中、画面は空白になります。
リモートOBWIを使用している場合、スイッチでインターフェイスが再起動の完了を待
機していることを通知するメッセージが表示されます。

SCSファームウェアのアップグレード

スイッチを最新のファームウェアに更新できます。

アップグレードによりメモリーが再プログラムされると、スイッチはソフト・リセットを

実行し、すべてのSIPセッションを終了します。 ターゲット・デバイスでSIPのファー

ムウェア・アップデートを実行中の場合に、表示されなくなるか、または接続されて

いないと表示されることがあります。アップデートが完了すると、ターゲット・デバ

イスは正常に表示されるようになります。

注意： ファームウェア・アップデート中にSIPの接続を解除したり、ターゲット・デバ

イスのパワー・サイクリング(一旦電源を切って入れ直す)を行ったりすると、モジ

ュールが作動不能となりSIPの工場返送や修理の必要が生じる場合があります。
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スイッチのファームウェアをアップグレードするには次の手順を実行します。

1 サイド・ ナ ビゲーション・バーから、Unit View → SCS → Tools →

Maintenance →Upgradeのタブの順に選択して、「Upgrade SCS Firmware」画

面を開きます。

2 ファームウェア・ファイルを読み込むには、次の方法のなかから1つを選択しま

す：Filesystem、TFTP、FTP、HTTP。

注: 「Filesystem」オプションは、リモートOBWIでのみ使用できます。

3 「Filesystem」を選択した場合、Browseを選択して、ファームウェア・アップグ

レード・ファイルの場所を指定します。

-または-

「TFTP」を選択した場合、サーバーのIPアドレスと読み込むファームウェ

ア・ファイルを入力します。

-または-

「FTP」または「HTTP」を選択した場合、ユーザー名とユーザー・パスワー

ド、およびサーバーのIPアドレスと読み込むファームウェア・ファイルを入

力します。

4 Upgradeボタンをクリックします。

SCSの構成およびSCSユーザー・データベースの保存と復元

スイッチの構成はファイルに保存できます。保存する設定ファイル内には、管理ス

イッチに関する情報が含まれます。 また、スイッチのローカル・ユーザー・データ

ベースを保存できます。いずれかのファイルを保存後、以前に保存した構成ファイ

ル、またはローカル・ユーザー・データベース・ファイルをスイッチに復元すること

もできます。

管理スイッチの構成または管理スイッチのユーザー・データベースを保存するに

は次の手順を実行します。

1 サイド・ナビゲーション・バーで、Unit View →SCS →Filesタブを順にクリック

します。

2 SCS ConfigurationタブまたはUser Databaseのいずれかをクリックし、次

にSaveタブをクリックします。
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3 ファイルの保存方法を、Filesystem、TFTP、FTP、HTTP PUTから選択します。

4 「TFTP」を選択した場合、サーバーIPアドレスと読み込むファームウェア・ファ

イル名を入力します。

-または-

「FTP」または「HTTP」を選択した場合、サーバーIPアドレス、ユーザー

名、ユーザー・パスワード、読み込むファームウェア・ファイル名を入力し

ます。

5 ダウンロード前にデータを暗号化する場合は、暗号化パスワードを入力しま

す。

6 Downloadボタンをクリックします。Save Asダイアログ・ボックスが開きます。

7 対象の場所に移動し、ファイルの名前を入力します。Saveボタンをクリックしま

す。

管理スイッチの構成または管理スイッチのユーザー・データベースを復元するに

は次の手順を実行します。

1 サイド・ナビゲーション・バーで、Unit View →SCS →Filesタブを順にクリック

します。

2 SCS ConfigurationタブまたはUser Databaseのいずれかをクリックし、次

にRestoreタブをクリックします。

3 ファイルの保存方法を、Filesystem、TFTP、FTP、HTTPから選択します。

4 「Filesystem」を選択した場合、Browseボタンをクリックして、ファームウェア・

アップグレード・ファイルの場所を指定します。

-または-

「TFTP」を選択した場合、サーバーIPアドレスと読み込むファームウェア・

ファイル名を入力します。

-または-

「FTP」または「HTTP」を選択した場合、サーバーIPアドレス、ユーザー

名、ユーザー・パスワード、読み込むファームウェア・ファイル名を入力し

ます。
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5 Browseボタンをクリックします。対象の場所に移動し、ファイル名を選択しま

す。Uploadボタンをクリックします。

6 元のファイルが暗号化されている場合は、復号化パスワードを入力します。

7 完了の画面が表示されたら、管理スイッチを再起動して、復元した設定を有効

にします。「ツール －再起動およびアップグレード」( ページ67) を参照してく

ださい。

更新の失敗からの回復するには：

更新後に、SCSが新しいファームウェアのバージョンで起動されない場合、次の手

順を使用して、以前のファームウェアのバージョンに戻すことができます。

1 シリアル・ケーブルをスイッチのリア・パネルにある10101ポートに接続しま

す。

2 10101ポートに接続されているコンピューターでターミナル・プログラムを実行

します。シリアル・ポートの設定は、9600ボー、8データ・ビット、1ストップ・ビッ

ト、パリティなし、フロー・コントロールなしにしてください。

3 スイッチをオンにします。

4 ターミナル・プログラムで、「Hit any key to stop autoboot」というメッセージが

表示されたら、いずれかのキーを押します。 メニューが表示されます。

5 1( Boot Alternate) を入力して、Enterキーを押します。 SCSは自動的に以前

のファームウェアのバージョンで再起動します。

6 SCSの再起動の後に、アップグレードを試みてください。

プロパティIDおよびロケーション設定
スイッチでは、ほとんどのデバイス･プロパティを、スイッチのWebブラウザを通じて

直接報告することができます。 「Identity」をクリックすると、「Unit Identification

Properties」が表示され、「Part Number」、「Serial Number」およびDellリモート・ア

クセス・キーのステータスが示されます。 「Unit Location Properties」画面

に「Site」、「Department」、Location」が表示されます。

注:ネットワーク設定を変更したあとは、スイッチを再起動する必要があります。
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バージョン情報の表示
「Version」画面には、現行アプリケーションのバージョンの情報、ブート、ビルド、

ハードウェア、UART、ビデオASICのバージョンが表示されます。この画面は読み

取り専用の画面です。

ネットワーク設定
注: 「Network」ダイアログ・ボックスの設定を変更できるのは、SCS管理者のみです。
他のユーザーには、表示のみのアクセスが許可されています。

サ イ ド・ ナ ビ ゲー シ ョ ン・ バー か ら、 Network を ク リ ッ ク し

て、「General」、「IPv4」、「IPv6」のタブを表示します。

一般ネットワーク設定を構成するには次の手順を実行します。

1 Networkタブをクリックし、次にGeneralタブをクリックして、「SCS General

Network Settings」画面を表示します。

2 「LAN Speed」ドロップダウン・メニューから、Auto-Detect、10 Mbps Half

Duplex、10 Mbps Full Duplex、100 Mbps Half Duplex、100 Mbps Full Duplex

のオプションのいずれか1つを選択します。

注:イーサネット・モードを変更した場合は、再起動する必要があります。

3 「ICMP Ping Reply」ドロップダウン・メニューから、EnabledまたはDisabledの

いずれかを選択します。

4 HTTPまたはHTTPSポートを確認もしくは変更します。 設定はデフォルト

のHTTP 80およびHTTPS 443となります。

5 Saveをクリックします。

IPv4ネットワーク設定を構成するには次の手順を実行します。

1 Networkタブをクリックし、次にAddressタブをクリックして、「IPv4 Settings」画

面を表示します。

2 IPv4ボタンをクリックします。

3 Enable IPv4チェックボックスをクリックしてオンまたはオフにします。
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4 「Address」、「Subnet」、「Gateway」の各フィールドに適切な情報を入力しま

す。 IPv4のアドレスは、xxx.xxx.xxx.xxxのドット記号式で入力します。

5 「DHCP」ドロップダウン・メニューから、EnabledまたはDisabledのいずれかを

選択します。

注: DHCPを有効にすると、「Address」、「Subnet」、「Gateway」の各フィールドに入力
した情報は無視されます。

6 Saveをクリックします。

IPv6ネットワーク設定を構成するには次の手順を実行します。

1 IPv6ボタンをクリックします。

2 「Address」、「Subnet」、「Prefix Length」の各フィールドに適切な情報を入力

し ま す。 IPv6 の ア ド レ ス は、FD00:172:12:0:0:0:0:33、 ま た は 略 式

のFD00:172:12::33の16進数表記で入力します。

3 「DHCP」ドロップダウン・メニューから、EnabledまたはDisabledのいずれかを

選択します。

注: DHCPv6を有効にすると、「Address」、「Gateway」、「Prefix length」の各フィール
ドに入力した情報は無視されます。

4 Saveをクリックします。

SNMP設定
SNMPは、ネットワーク管理アプリケーションとスイッチ間で管理情報を通信するた

めに使用されるプロトコルです。 他のSNMPマネージャーは、MIB-IIにアクセスす

ることにより、スイッチと通信できます。 SNMP画面を開くと、OBWIはユニットか

らSNMPパラメーターを取得します。

SNMP画面から、システム情報とコミュニティー・ストリングを入力できます。また、

スイッチを管理するステーション、さらにスイッチからSNMPトラップを受信するス

テーションを指定できます。Enable SNMPを選択すると、ユニットはUDPポート161

を介したSNMP要求に応答します。

一般SNMP設定を構成するには次の手順を実行します。

1 SNMPをクリックして、「SNMP」画面を開きます。
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2 Enable SNMPチェックボックスをクリックして有効にし、スイッチがUDPポー

ト161を介したSNMP要求に応答できるようにします。

3 「Name」フィールドにシステムの完全修飾ドメイン名を、「Contact」フィールド

にノードの連絡先担当者を入力します。

4 「Read」、「Write」、「Trap」の各コミュニティー名を入力します。 これらの名称

は、SNMPアクションで使用が必須となっているコミュニティー・ストリングを指

定します。 「Read」と「Write」のストリングは、UDPポート161を介したSNMPに

のみ適用され、スイッチへのアクセスを保護するパスワードとして機能します。

この値は、64文字以内の範囲で受け入れられます。 これらのフィールドを空

欄のまま残すことはできません。

5 スイッチの管理を許可する最大4台の管理ワークステーションのアドレス

を、「Allowable Managers 」フィールドに入力します。 または、これらのフィー

ルドを空欄のままにして、すべてのワークステーションにSCSの管理を許可す

ることもできます。

6 Saveをクリックします。

監査イベントの設定
イベントはスイッチによって管理ステーションに送信される通知で、何らかの処置

が必要である事象が発生したことを示します。

個別のイベントを有効にするには次の手順を行います。

1 Auditingをクリックして、「Events」画面を開きます。

2 一覧の適切なチェックボックスをオンにして、通知を生成するイベントを指定し

ます。

-または-

Event Nameの横にあるチェックボックスをオン／オフにすると、リスト内

のすべてをオンまたはオフにできます。

3 Saveをクリックします。
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イベント送信先の設定
監査イベントを、SNMPトラップ送信先とSyslogデバイスに送信されるように構成で

きます。 「Events」画面で有効にされたイベントは、「Event Destination」画面に一

覧で表示されているすべてのデバイスに送信されます。

1 AuditingとDestinationsタブをクリックして、「Event Destinations」画面を開き

ます。

2 「SNMP Trap Destination」フィールドに、このスイッチがイベントを送信する管

理ワークステーションのアドレスとSyslogデバイスをそれぞれ4つまで入力しま

す。

3 Saveをクリックします。

ポート設定 - SIPの構成
SCSから、接続されているSIPの一覧や、各SIPの正常性、EID、ポート、状態、アプ

リケーションおよびインターフェイス・タイプについての情報も表示できます。SIP

の1つをクリックすると、スイッチ・タイプ、ブート・バージョン、アプリケーション・

バージョン、ハードウェア・バージョン、FPGAバージョン、利用可能なバージョン、

アップグレード・ステータスなどの追加情報が表示できます。

また、オフラインのSIPを削除する、自動アップグレードを有効にする、SIPファーム

ウェアをアップグレードすることもできます。

SIPの削除

オフラインSIPを削除するには次の手順を実行します。

1 サイド・ナビゲーション・バーから、Ports → SIPsの順にクリックして、「SIPs」

画面を開きます。

2 該当するSIPのチェックボックスをクリックします。

3 Delete Offlineをクリックします。

SIPのアップグレード

SIPのアップグレード機能を使用すると、SCS管理者はSIPを利用可能な最新のフ

ァームウェアにアップデートできます。このアップデートは、スイッチのユーザー・
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インターフェイスまたはAvocent管理ソフトウェアを使用して実行できます。

メモリーがアップグレードされると、スイッチはソフト・リセットを実行し、すべて

のSIPセッションを終了します。 SIPのファームウェアがアップデート中のデバイス

は、接続解除されたと表示される場合があります。 アップデートが完了すると、デ

バイスは正常に表示されるようになります。

SIPの自動アップグレードを行うようにSCSが構成されている場合は、スイッチがア

ップデートされると、SIPも自動的にアップデートします。スイッチのファームウェア

をアップデートするには、「ツール －再起動およびアップグレード」( ページ67) 、

またはAvocent管理ソフトウェアのオンライン・ヘルプを参照してください。通常の

アップグレード処理中に問題が発生した場合も、必要に応じて、SIPは強制的にア

ップグレードされることがあります。

注: ファームウェア・アップグレード・ファイルについては、http://www.dell.comをチェ
ックしてください。

SIPの自動アップグレード機能を変更するには：

1 サイド・ナビゲーション・バーから、Ports → SIPsの順にクリックして、「SIPs」

画面を開きます。

2 アップグレードするSIPの横にあるチェックボックスを選択し、Enable Auto-

Upgradeをクリックします。

注意：ファームウェア・アップデート中にSIPの接続を解除したり、デバイスのパ

ワー・サイクリング(一旦電源を切って入れ直す)を行ったりすると、モジュールが

作動不能となりSIPの工場返送や修理の必要が生じる場合があります。

SIPファームウェアをアップグレードするには：

1 サイド・ナビゲーション・バーから、Ports → SIPsの順にクリックして、「SIPs」

画面を開きます。

2 変更するSIPの横にあるチェックボックスを選択します。

3 Choose an operationを選択して、Upgradeを選択します。

4 設定が正しい場合は、Upgradeをクリックします。

USB速度を設定するには次の手順を実行します。

注: この選択は、USB2 SIPにのみ適用されます。
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1 サイド・ナビゲーション・バーから、Ports → SIPsの順にクリックして、「SIPs」

画面を開きます。

2 変更するSIPの横にあるチェックボックスを選択します。

セッションの起動
注:セッションを起動するには、Java 1.6.0_11以降が必要です。

セッションを起動するには次の手順を実行します。

1 サイド・ナビゲーション・バーから、Target Devicesを選択します。利用可能な

デバイスの一覧が表示されます。

2 Action列に、適用可能な操作である、KVMセッションが表示されます。適用可

能な操作は、セッションを起動するように選択したターゲット・デバイスによっ

て異なります。指定したターゲット・デバイスに適用可能な操作が複数ある場

合は、ドロップダウン矢印をクリックして、一覧から適用する操作を選択しま

す。

ターゲット・デバイスが使用中の場合、プリエンプト操作のレベルが現在のユー

ザーのレベルと同等またはそれ以上であれば、デバイスに強制的に接続してアク

セスできます。

ローカルUIからアクティブなセッションに切り替えるには(ローカル・ユーザーの

み) ：

1 サイド・ナビゲーション・バーから、Local Sessionを選択します。

2 Resume Active Sessionチェックボックスをオンにします。「ビデオ・ビューア」

ウィンドウが表示されます。

注: KVMリモート・アクセスにはDell RAKが必要です。

注: 「Active Sessions」画面から、アクティブなセッションの一覧を表示することがで
きます。各セッションについての以下の情報が一覧されます：ターゲット・デバイス、
所有者、リモート・ホスト、継続時間、タイプ。
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一般セッションの設定

一般セッションを構成するには次の手順を実行します。

1 サイド・ナビゲーション・バーから、Sessions → Generalの順に選択しま

す。「General Session Settings」画面が表示されます。

2 Enable Inactivity Timeoutチェックボックスをオンまたはオフにします。

3 「Inactivity Timeout」フィールドには、セッションを閉じる非アクティブ時間を入

力します(1分～90分)。

4 「Login Timeout」フィールドには、再ログインを必要とする非アクティブ時間を

入力します。( 21秒～120秒)

5 Enable Preemption Timeoutチェックボックスをオンまたはオフにします。

6 「Preemption Timeout」フィールドには、セッションがプリエンプトされることを

知らせるメッセージを表示する時間を入力します( 1秒～120秒) 。

7 適用できるセッションの共有オプション( Enabled、Automatic、Exclusive、また

はStealth) を選択します。

8 1～50からInput Control Timeoutの値を選択します。ただし、1は0.1秒を表し

ます。

9 Saveをクリックします。

ローカル・ユーザー・アカウントの設定

注:ユーザー・アカウントの設定は、Dell RAKがインストールされているときにサポー
トされます。

OBWIでは、管理者が定義したユーザー・アカウントを通して、ローカル・アクティビ

ティおよびログインがセキュアに実行されます。管理者は、サイド・ナビゲーショ

ン・バーのUser Accountsを選択して、ユーザーの追加と削除、ユーザーのプリエ

ンプト操作の定義、アクセス・レベルの変更、パスワードの変更などを実行できま

す。

アクセス・レベル

注:複数のアクセス・レベルは、Dell RAKがインストールされているときにサポートさ
れます。
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ユーザー･アカウントが追加されるとき、ユーザーに対して割り当てられるアクセ

ス･レベルは、SCS Administrator、User Administrator、およびUserのいずれかで

す。

操作 SCS Administrator User Administrator User

インターフェイスのシステ

ム・レベル設定の構成
可 不可 不可

アクセス権の構成 可 可 不可

ユーザー・アカウントの追

加、変更、削除

すべてのアクセス・ レ

ベルで可

可( User お よ びUser
Administratorのみ)

不可

自分自身のパスワードの

変更
可 可 可

サーバーへのアクセス 可、すべてのサーバー 可、すべてのサーバー

許 可 さ

れていれ

ば可

表 4.4: アクセス・レベルによって許可される操作

新規のユーザー･アカウントを追加するには( User AdministratorまたはSCS

Administratorのみ)次の手順を実行します。

1 サイド・ナビゲーション・バーで、User Accounts → Local User Accountsの順

に選択して、「Local User Accounts」画面を開きます。

2 Addボタンをクリックします。

3 新規ユーザーのユーザー名とパスワードを該当欄に入力します。

4 新規ユーザーのアクセス･レベルを選択します。

注:複数のアクセス・レベルは、Dell RAKがインストールされているときにサポートさ
れます。

5 ユーザー・アカウントに割り当てる、任意の使用可能なデバイスを選択し

て、Addをクリックします。
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注: User AdministratorとSCS Administratorは、すべてのターゲット･デバイスにアク
セスできます。

6 Saveをクリックします。

ユーザー･ ア カウ ン ト を削 除 す る に は( User Administrator ま た はSCS

Administratorのみ)次の手順を実行します。

1 サイド・ナビゲーション・バーで、User Accounts→ Local Accountsの順に選

択して、「Local User Accounts」画面を開きます。

2 削除するアカウントの左にあるチェックボックスをそれぞれクリックし

て、Deleteをクリックします。

ユーザー・アカウントを編集するには(管理者またはアクティブ・ユーザーのみ) 次

の手順を実行します。

1 サイド・ナビゲーション・バーでUser Accounts→ Local Accountsの順に選択

にします。「Local User Accounts」画面が表示されます。

2 編集するユーザーの名前をクリックします。 ユーザー･プロファイルが表示さ

れます。

3 画面にユーザー情報を入力し、Saveをクリックします。

バーチャル・メディア・セッションの設定

バーチャル・メディア・オプションを設定するには次の手順を実行します。

1 サイド・ナビゲーション・バーから、Sessions → Virtual Mediaの順に選択し

て、「Virtual Media Session Settings」画面を開きます。

2 Virtual Media locked to KVM Sessionsチェックボックスをオンまたはオフにし

ます。

3 Allow Reserved Sessionsチェックボックスをオンまたはオフにします。

4 ドロップダウン・メニューのVirtual Media Access Modeから、Read-Onlyまた

はRead-Writeのいずれかをオンにします。

5 サポートする暗号化レベルを選択します。

6 Saveをクリックします。
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7 バーチャル・メディアを有効にする各SIPの横にあるチェックボックスをオンに

し、Enable VMをクリックします。

-または-

バーチャル・メディアを無効にする各SIPの横にあるチェックボックスをオ

ンにし、Disable VMをクリックします。

バーチャル・メディア・オプション

「Virtual Media Session Settings」画面に表示されるオプションを使用して、バーチ

ャル・メディア・セッション中のスイッチの動作を指定できます。次の表は、バーチ

ャル・メディア・セッションに対して設定できるオプションの概要です。

ローカル・ユーザー

ローカル・ユーザーは、「Local Session」画面からバーチャル・メディアの動作を指

定できます。バーチャル・メディア・セッションの接続／接続解除に加えて、次の表

に一覧されている設定を構成することができます。

設定 説明

CD ROM/

DVD ROM

最初に検出されたCD-ROMドライブまたはDVD-ROM( 読み取り専用) ド
ライブに、バーチャル・メディア・セッションを確立できます。 このチェックボ

ックスをオンにすると、バーチャル・メディアのCD-ROMまたはDVD-ROMから

デバイスへの接続が確立します。 オフにすると、バーチャル・メディア

のCD-ROMまたはDVD-ROMからデバイスへの接続が終了します。

大容量記憶

装置

バーチャル・メディア・セッションを最初に検出された大容量記憶装置に

確立することができます。 このチェックボックスを有効にすると、バーチャ

ル・メディアの大容量記憶装置からデバイスへの接続が確立します。

無効にすると、バーチャル・メディアの大容量記憶装置からデバイスへの

接続が終了します。

表 4.5: ローカル・バーチャル・メディア・セッションの設定

アボセント・ユーザー・アカウントの設定
注:ユーザー・アカウントの設定は、Dell RAKがインストールされているときにサポー
トされます。
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Avocent管理ソフトウェア・デバイスのIPアドレスを指定すると、管理ソフトウェア・

デバイスを使って、管理されていないスイッチに接続して登録できます。

デバイスIPアドレスを構成するには

1 サイド・ナビゲーション・バーでUser Accounts →Avocentの順に選択にしま

す。「Avocent Management Software Settings」画面が表示されます。

2 接続するデバイスIPアドレスを入力します。 IPアドレスは最大で4つ入力できま

す。

3 スクロール・バーを使用して、再試行間隔を選択します。

4 デバイスに登録されているSCSの関連を解除するには、Disassociateボタンを

クリックします。

5 Saveをクリックします。

Override Admin
注: Override Adminは、Dell RAKがインストールされているときにサポートされます。

ネットワーク障害が起きた場合に備えるには、他の設定を行う前に、Override

Admin Accountを構成してください。

Override Admin AccountをOBWIで構成するには：

1 User Accountsをクリックして、Override Adminをクリックします。

2 ユーザーに割り当てるユーザー名とパスワードを入力し、「Verify Password」

フィールドにパスワードを再度入力して確認します。

3 Saveをクリックします。

アクティブ・セッション
「Active Sessions」画面から、アクティブなセッションの一覧と各セッションについ

ての以下の情報を表示することができます：ターゲット・デバイス、所有者、リモー

ト・ホスト、継続時間、タイプ。
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セッションの終了
セッションを終了するには次の手順を実行します。

1 サイド・ナビゲーション・バーで、Active Sessionsを選択して、「SCS Active

Sessions」画面を表示します。

2 目的のターゲット・デバイスの横にあるチェックボックスをオンにします(複数

可) 。

3 Disconnectをクリックします。

注:関連付けられているロック状態のバーチャル・メディア・セッションがある場合は、
そのセッションも接続解除されます。

セッションを終了するには(ローカル・ユーザーのみ) ：

1 サイド・ナビゲーション・バーから、Local Sessionを選択します。

2 Disconnect Active Sessionチェックボックスをオンにします。
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ビデオ・ビューア

OBWIを使用してスイッチに取り付けられているターゲット・デバイスとのKVMセッ

ションを操作するには、ビデオ・ビューアを使用します。 Dell RAKがインストールさ

れている場合は、OBWIで「KVM Session」のリンクが「ターゲット・デバイス」ページ

に表示されます。このページはホーム・ページとしても参照されます。デバイスの

一覧に加え、リモートKVMアクセスに関連する追加のオプション／ページが利用

できるようになります。 ビデオ・ビューアを使用してデバイスに接続すると、ターゲ

ット・デバイスのデスクトップが別個のウィンドウに表示されます。このウィンドウ

には、ローカル・カーソルとターゲット・デバイスのカーソルの両方が含まれていま

す。

注: リモート・アクセス機能を使用するには、Dell RAKがインストールされていなけれ
ばならず、OSCARまたはセットアップ・ポートを使用してネットワーク設定を構成する
必要があります。 1081AD/2161ADスイッチは、ネットワーク設定が一旦構成される
と、Dell RAKなしでは低下したレベルでの管理は可能です。

スイッチのOBWIソフトウェアでは、Javaベースのプログラムを使用して、「ビデオ・

ビューア」ウィンドウを表示します。スイッチのOBWIは、初めて起動したときにビデ

オ・ビューアを自動的にダウンロードして、インストールします。

注:セッションを起動するには、Java 1.6.0_11以降が必要です。

注:スイッチのOBWIは、Java Resource Engine( JRE) をインストールしません。 JRE
は無料でhttp://www.sun.comからダウンロードできます。

注:スイッチのOBWIは、システム・メモリーを使用して、「ビデオ・ビューア」ウィンドウ
内にイメージを保存して表示します。 開かれた「ビデオ・ビューア」ウィンドウには、追
加のシステム・メモリーがそれぞれ必要です。 クライアント・デバイスで色を8ビット
に設定すると、「ビデオ・ビューア」ウィンドウあたり1.4 MBのメモリーが必要です。16
ビットに設定すると2.4 MB、32ビットに設定すると6.8 MBのメモリーが必要です。 シス
テム・メモリーが許容する(通常4つ)以上の「ビデオ・ビューア」ウィンドウを開こうと
すると、メモリー不足エラーが発生し、要求した「ビデオ・ビューア」ウィンドウは開き
ません。
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アクセスしようとしているデバイスを別のユーザーが表示中である場合、このユー

ザーのプリエンプト操作レベルと同等またはそれ以上のプリエンプト操作レベルが

自分に許可されていれば、相手のユーザーをプリエンプトするよう指示するメッ

セージが表示されます。また、SCS管理者も、「Active Session」のページから、ア

クティブなユーザーの接続を解除できます。詳細については、「アクティブ・セッシ

ョン」( ページ81) を参照してください。

図5.1: 「ビデオ・ビューア」ウィンドウ(通常のウィンドウ・モード)
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番

号
説明

1
タイトル・バー：表示されているターゲット・デバイスの名前を表示します。全画面

表示モードではタイトル・バーが隠され、ターゲット・デバイス名がメニューとツール

バーの間に表示されます。

2 画鋲アイコン：メニューとツールバーをロックして、常に表示されるようにします。

3

メニューおよびツールバー：「ビデオ・ビューア」ウィンドウ機能の多くには、ここからア

クセスできます。画鋲を使用していない場合、メニューとツールバーは表示／非表

示状態になります。ツールバー上にカーソルを移動すると、メニューとツールバーが

表示されます。ツールバーには10個までのコマンドやマクロ・グループ・ボタンを表示

できます。デフォルトでは、ツールバーには、シツールバー上には「シングル・カーソ

ル」モード、更新、自動ビデオ調整、ローカルカーソルを合わせるの各ボタンが表

示されます。詳細については、「ビデオ・ビューア」(ページ83)および「マクロ」(ペー

ジ105) を参照してください。

4
マクロ・ボタン：ターゲット・デバイスへの送信に通常使われるキーボード・シーケン

スです。

5
接続ステータス・インジケーター：このサーバーのSCSに接続されているユーザーの

状態を示します。モードは、排他、基本的なアクティブ接続、プライマリ・アクティブ

共有、セカンダリ・アクティブ共有、パッシブ共有、ステルス、スキャンです。

6

スマート・カードのステータス・インジケーター：スマート・カードがスマート・カード・

リーダーに挿入されているかどうかを示します。「ビデオ・ビューア」画面のスマート・

カード・アイコンが半透明の場合は、スマート・カード・オプションが使用できない

か、または無効であることを示します。スマート・カードがマッピングされている場合

は、アイコンは緑です。

7 表示領域：デバイスのデスクトップにアクセスします。

8
フレーム：「ビデオ・ビューア」ウィンドウのサイズを変更するには、フレームをクリックし

てホールドします。

表 5.1: ビデオ・ビューアの説明
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ツールバーの変更
表示／非表示状態(つまり、画鋲によって所定の位置にロックされていない)にあ

るツールバーが「ビデオ・ビューア」ウィンドウで非表示になるまでの秒数を指定

することができます。

ツールバーの非表示時間を指定するには次の手順を実行します。

1 「ビデオ・ビューア」ウィンドウのメニューからTools → Session Optionsを選択

します。

-または-

Session Optionsボタンをクリックします。

Session Optionsダイアログ・ボックスが表示されます。

2 Toolbarタブをクリックします。

3 矢印キーを使用して、ツールバーが非表示になるまでの待ち時間(秒数) を指

定します。

4 OKをクリックして変更を保存し、ダイアログ・ボックスを閉じます。

ウィンドウ・サイズ
注: 「View - Scaling」コマンドは、「ビデオ・ビューア」ウィンドウが全画面表示モードに
なっている場合は使用できません。

スイッチのOBWIを初めて使用した場合、開いている「ビデオ・ビューア」ウィンドウ

はすべて、ユーザーが値を変更するまで、1024 x 768の解像度で表示されます。

「ビデオ・ビューア」ウィンドウは、それぞれ異なる解像度に設定できます。

自動スケールが有効になっている場合は、セッション中にウィンドウ･サイズが変

わっても、スイッチのOBWIは表示を自動調整します。 ターゲット・デバイスの解像

度がセッション中に変更された場合でも、表示は自動調整されます。

「ビデオ・ビューア」ウィンドウの解像度を変更するには次の手順を実行します。

1 View - Scalingコマンドを選択します。

2 希望の解像度を選択します。
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表示形態の調整
「ビデオ・ビューア」ウィンドウ内のメニューやタスク・ボタンでは、次の機能を実行

できます：

• マウス・カーソルの位置を合わせる。

• 画面を更新する。

• 全画面表示モードを有効／無効にする。全画面表示モードが有効の場合は、

イメージはデスクトップに合わせて最大1600 x 1200または1680 x 1050( ワイ

ドスクリーン)のサイズまで調整されます。デスクトップの解像度がより高い場

合は、次の現象が発生します。

• 全画面画像はデスクトップの中央に表示され、この外枠となる「ビデオ・ビ

ューア」ウィンドウ領域が黒く表示されます。

• メニューとツールバーはロックされ、常に表示された状態になります。

• セッション画像の自動／フル／手動スケーリングのサイズ調整を有効にす

る。

• フル・スケールでは、デスクトップ・ウィンドウは固定され、デバイスの画

像はウィンドウに合わせてサイズ調整されます。

• 自動スケールでは、表示中のターゲット・デバイスの解像度に合わせてデ

スクトップ・ウィンドウのサイズが調整されます。

• 手動スケールでは、サポートされている画像スケーリング解像度がドロッ

プダウン・メニューに表示されます。

• セッション画像の色の階調を変更する。

マウスのカーソルの位置を合わせるには：

「ビデオ・ビューア」ウィンドウのツールバーのAlign Local Cursorボタンをクリック

します。ローカル・カーソルの位置がリモート・デバイス上のカーソルと揃います。

注:カーソルが調整した位置からずれた場合は、接続されているデバイスでのマウ
ス加速度をオフにしてください。
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画面を更新するには、「ビデオ・ビューア」ウィンドウで、Refresh Imageボタンをク

リックするか、または「ビデオ・ビューア」ウィンドウのメニューからView →Refresh

の順に選択します。デジタル化されたビデオ画像が完全に再生成されます。

全画面表示モードを有効にするには、Maximizeボタンをクリックするか、「ビデオ・

ビューア」ウィンドウのメニューからView → Full Screenの順に選択します。デスク

トップ・ウィンドウは非表示の状態になり、アクセス中のデバイスのデスクトップの

みが表示されます。デフォルトの解像度は1024 x 768です。画面は最大1600 x

1200( 標準) または1680 x 1050( ワイドスクリーン) にサイズ変更されます。モニ

ターのデスクトップ解像度がこれより高い場合は、フル・スクリーン画像が黒の背

景で縁取られます。浮動ツールバーが表示されます。

「全画面表示」モードを無効にするには、浮動ツールバー上のFull Screen Modeボ

タンをクリックして、デスクトップ・ウィンドウに戻ります。

フル・スケーリングを有効にするには、「ビデオ・ビューア」ウィンドウのメニューか

らView → Scalingの順に選択して、Full Scaleを選択します。表示中のターゲット・

デバイスの解像度に合わせて、デバイスの画像が自動的に調整されます。

手動スケールを有効にするには、「ビデオ・ビューア」ウィンドウのメニューか

らView →Scalingの順に選択します。ウィンドウに適用するサイズを選択します。

利用可能な手動スケールのサイズはシステムによって異なります。

イメージの更新
Manual Video Adjustダイアログ・ボックスのRefresh Imageボタンをクリックすると、

デジタル化されたビデオ画像が完全に再生成されます。

注:また画像の更新は、「ビデオ・ビューア」ウィンドウのメニューのView → Refresh
を選択することでも実行できます。

ビデオの設定
通常、「ビデオ・ビューア」ウィンドウの自動調整機能を選択した場合には、調整可

能な範囲で最高のビデオ画像に最適化されます。ただし、Dellのテクニカル・サ

ポートに問い合わせた上で、「ビデオ・ビューア」ウィンドウ・メニューのTools →

Manual Video Adjustコマンドを使用するか、Manual Video Adjust ボタンをクリック

して、ユーザーが画質を微調整することができます。これにより、Manual Video
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Adjustダイアログ・ボックスが表示されます。ビデオ調整はデバイス単位の設定で

す。

ユーザーは、ダイアログ・ボックスの左下にあるパケット・レートを見ながら、静的

画面をサポートするために必要なパケット数／秒のレベルを確認できます。

ウィンドウのビデオ画質を手動で調整するには次の手順を実行します。

注:次のビデオ調整を行うには、必ずDellテクニカル・サポートとの連携が必要です。

1 「ビデオ・ビューア」ウィンドウのメニューからTools →Manual Video Adjustを

選択します。

-または-

Manual Video Adjustボタンをクリックします。

Manual Video Adjustダイアログ・ボックス(図 5.2) が表示されます。

図5.2: 「Manual VideoAdjust」ダイアログ・ボックス
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番号 説明 番号 説明

1 画像キャプチャーの幅 9 自動ビデオ調整

2 ピクセル・サンプリング／微調整 10  画像の更新

3 画像キャプチャーの水平位置 11 調整バー

4 画像キャプチャーの垂直位置 12 ビデオ・テスト・パターン

5 コントラスト 13 Help

6 明るさ 14 Performance Monitor

7 ノイズのスレッシュホールド 15 「Close」ボタン

8 スレッシュホールド優先順位

表 5.2: 「Manual Video Adjust」ダイアログ・ボックスの説明

2 調整したい機能に対応するアイコンをクリックします。

3 まず、Contrastスライダー・バーを移動し、その後Min( -) またはMax( +) ボタン

をクリックして、押されている各アイコンに対応するパラメーターを微調整しま

す。調整は即座に「ビデオ・ビューア」ウィンドウに表示されます。

4 完了したら、CloseをクリックしてManual Video Adjustダイアログ・ボックスを閉

じます。

ターゲット・ビデオの設定

イメージ・キャプチャーの幅、ピクセル・サンプリング／微調整、イメージ・キャプチ

ャーの水平位置、イメージ・キャプチャーの垂直位置の調整は、デバイスのビデオ

がどのようにキャプチャーされ、デジタル化されるかに影響しますが、ほとんど変

更されることはありません。

イメージ・キャプチャ・パラメーターは、自動調整機能によって自動的に変更されま

す。正確な調整を個別に行うためには、デバイスに特別のイメージが必要になり

ます。
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自動ビデオ調整

大抵の場合、ビデオ設定をデフォルト設定から変更する必要はありません。シス

テムが自動的に調整を行い、最適なビデオ・パラメーターが適用されます。スイッ

チのOBWIは、ビデオ・パラメーターが静的画面用ビデオ・パケットの送信なし( ゼ

ロ)に設定されているときに最高の性能を発揮します。

ビデオ・パラメーター値を調整するには、Manual Video Adjustダイアログ・ボックス

でAutomatic Video Adjustmentボタンをクリックします。

注:また、ビデオを自動調整することもできます。この場合は、「ビデオ・ビューア」の
ウィンドウ・メニューから、「Tools → Automatic Video Adjust」を選択するか、また
は「Automatic Video Adjust」ツールバー・アイコンをクリックします。

ビデオ・テスト・パターン

ビデオ・テスト・パターンを切り替えるには、Manual Video Adjustダイアログ・ボッ

クスでVideo Test Patternボタンをクリックします。Video Test Patternボタンをもう

一度クリックすると、通常のビデオ画像に切り替わります。

ベンダー固有のビデオ設定

ビデオ設定はメーカー間で大幅に変わります。 Dellのオンライン･データベースで

は、さまざまなビデオ･カード(特にSun固有の製品)での最適なビデオ設定に関す

るデータを提供しています。 この情報は、Dellのオンライン・ノレッジ・ベースから

検索していただくか、Dellテクニカル・サービスまでお電話にてお問い合わせくださ

い。

色の設定
Dambrackas Video Compression®( DVC) アルゴリズムでは、リモート・セッション・

ウィンドウでの表示色数を調整できます。表示色を増やすと色の忠実度がベスト

になり、色数を減らすとネットワーク・データ転送量を減らすことができます。必要

に応じて調整してください。

「ビデオ・ビューア」ウィンドウは、「色－最適化」( 更新レートは最も遅くなりま

す) 、「圧縮－最適化」( 最も速い更新レート) 、またはこの2つの組み合わせ、また

は「グレースケール」で表示できます。
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個々のポートとチャンネルの色の階調は、リモート・セッション・ウィンドウでView

Colorコマンドを選択して指定できます。この設定はチャンネル別に保存されます。

コントラストと明るさ

「ビデオ・ビューア」ウィンドウのイメージが暗すぎたり明るすぎたりする場合

は、Tools → Automatic Video Adjustを選択するか、Automatic Video Adjustボタ

ンをクリックします。このコマンドはまた、Video Adjustmentsダイアログ・ボックス

でも使用できます。大概の場合、これでビデオの問題は修正されます。

Auto Adjustを数回クリックしてもコントラストと明るさが希望どおりに調整されない

場合は、これらを手動で調整することで改善できる場合があります。明るさのレベ

ルを上げてみます。コントラストを変える前に、10目盛り以上増やさないでくださ

い。一般的に、コントラストはほんのわずかの変更ですむはずです。

ノイズの設定
ビデオ通信のノイズがパケット／秒の読み取り値に影響して値が高くなることがあ

ります。この場合、カーソルを動かすとカーソルの周りで小さなドットが変動するた

め分かります。 しきい値を変更すると、「より安定した」画面が得られ、カーソル・ト

ラッキングを改善できます。

通常のビデオ圧縮を使用している場合、ノイズのしきい値と優先順位のしきい値は

変更できます。しきい値をデフォルトに戻すには、Auto Adjust Videoをクリックしま

す。

注: ノイズのしきい値をゼロに設定すると、ビデオが継続的に更新されるため、ネット
ワーク利用率が上がり、ビデオのちらつきが起こります。 ノイズのしきい値は最大に
設定し、移動するマウス・カーソルの下のピクセルの色が復元される間も、システム
性能を効率化することをお薦めしています。

注: ノイズのしきい値を調整する場合、大きく調整するにはスライダー・バーを、微調
整するにはスライダー・バーの両端のプラス( +)ボタンとマイナス( -)ボタンを使用し
ます。

色の階調の変更に関する詳細は、「表示形態の調整」( ページ87) を参照してくださ

い。
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マウスの設定
「ビデオ・ビューア」ウィンドウのマウス・オプションでは、カーソル・タイプ、カーソ

ル・モード、マウス・スケール、位置合わせ、およびリセットを調整できます。マウ

スの設定は、デバイスで固有です。すなわち、デバイスごとに異なる設定ができま

す。

注:マウスをプラグ・アンド・リプラグする機能をデバイスでサポートしていない場合(
新しいPCのほとんどがこの機能をサポートしています) 、マウスは使用不能になり、
デバイスの再起動が必要になります。

カーソル・タイプ

「ビデオ・ビューア」ウィンドウ(図 5.3) ではローカルのマウス・カーソル用に5種類

の表示オプションがあります。また、カーソル「なし」か、デフォルト設定にすること

もできます。

「Single Cursorル」モードでは、「ビデオ・ビューア」ウィンドウのローカル( 第二)

カーソルの表示がオフになり、ターゲット・デバイスのマウス・ポインターだけが表

示されます。表示されるマウスの動きは、ターゲット・デバイスのリモート・カーソ

ルのものだけになります。 「Single Cursor」モードは、ローカル・カーソルが不要な

場合に使用します。
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図5.3:ローカルとリモートの両方のカーソルが表示された状態の「ビデオ・ビューア」ウィンドウ

番号 説明

1 リモート・カーソル

2 ローカル・カーソル

表 5.3: 図5.3の説明

「ビデオ・ビューア」ウィンドウがどのカーソル・モードになっているかは、タイトル・

バーに、「Single Cursor」モードの終了に使用するキーストロークと共に表示され

ます。「Single Cursor」モードを終了させるためのキーストロークは、Session

Optionsダイアログ・ボックスで定義できます。
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注: クライアント・デバイスに送られる前にキーストロークをキャプチャーするデバイ
スを使用している場合は、マウス・ポインターの復元にこれらのキーを使用すること
は避けてください。

「Single Cursor」モードを開始するには、「ビデオ・ビューア」のウィンドウ・メニュー

からTools → Single Cursor Modeの順に選択するか、またはSingle Cursor Mode

ボタンをクリックします。ローカル・カーソルは表示されず、すべての動きがターゲ

ット・デバイスに対応します。

既存の「Single Cursor」モードを終了するためのキーを選択するには：

1 「ビデオ・ビューア」ウィンドウのメニューからTools → Session Optionsを選択

します。

-または-

Session Optionsボタンをクリックします。

Session Optionsダイアログ・ボックスが表示されます。

2 Mouseタブをクリックします。

3 「Single Cursor」モード領域内のドロップダウン・メニューから、終了用キース

トロークを選択します。

4 Saveをクリックして設定内容を保存します。

「Single Cursor」モードを有効にした場合、先ほど指定したキーを使用すれば、「通

常のデスクトップ」モードに戻れます。

「Single Cursor」モードを終了するには、タイトル・バーに表示されている終了用の

キーを押します。

マウス・カーソルの設定を変更するには次の手順を実行します。

1 「ビデオ・ビューア」ウィンドウのメニューからTools → Session Optionsを選択

します。

-または-

Session Optionsボタンをクリックします。

Session Optionsダイアログ・ボックスが表示されます。

2 Mouseタブをクリックします。

3 「Local Cursor」パネルでマウス・カーソル・タイプを選択します。
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4 OKをクリックして設定内容を保存します。

マウス・スケーリング

Linuxの以前バージョンの一部では、マウス加速度の調整がサポートされていませ

んでした。 これらの古いバージョンにインストールする必要がある場合は、事前設

定されている3種類のマウス・スケール・オプションから選ぶか、またはカスタム・ス

ケールを設定できます。 既定の設定にはデフォルト( 1:1) 、高( 2:1) 、または

低( 1:2) があり、次のようになっています：

• 1:1のスケール率では、デスクトップ・ウィンドウでのマウスのすべての動き

は、実際のマウスの動きと等しい動きとしてターゲット・デバイスに送られま

す。

• 2:1のスケール率では、同一のマウスの動きは2倍速の動きとして送られます。

• 1：2のスケール率では、この値は2分の1になります。

マウス・スケールを設定するには：

1 「ビデオ・ビューア」ウィンドウのメニューからTools → Session Optionsを選択

します。

-または-

Session Optionsボタンをクリックします。

Session Optionsダイアログ・ボックスが表示されます。

2 Mouseタブをクリックします。

3 規定の設定の1つを使用するには、該当するオプション・ボタンをオンにしま

す。

-または-

カスタム・スケールを設定するには：

a. Customオプション・ボタンをクリックして、XフィールドとYフィールドを有効

にします。

b. スケール値を「X」フィールドと「Y」フィールドに入力します。マウスの各入

力に対し、マウスの動きは、XとYの各スケール係数を乗じた動きとなりま

す。有効な入力範囲は、0.25～3.00です。
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マウスの位置合わせと同期

スイッチのOBWIではマウスからのフィードバックを継続的に得ることはできないた

め、スイッチでのマウスの動作がホスト・システムのマウス動作と同期しなくなるこ

とがあります。 マウスやキーボードが正しく応答しなくなった場合は、マウスを調

整して適切なトラッキングが得られるようにできます。

位置合わせを調整することで、ローカル・カーソルがリモート・ターゲット・デバイス

のカーソルと揃うようになります。 リセットを行うと、マウスとキーボードを一度接続

解除して接続し直したかのような効果が得られます。

マウスの位置を再度合わせるには、「ビデオ・ビューア」ウィンドウのツールバー

でAlign Local Cursorボタンをクリックします。

バーチャル・メディア
バーチャル・メディア機能を使用すると、クライアント・デバイス上のユーザーは、

そのマシンの物理ドライブをバーチャル・ドライブとしてターゲット・デバイス上にマ

ッピングできます。 クライアント・デバイスはまた、ISOまたはフロッピーのイメー

ジ・ファイルをバーチャル・ドライブとしてターゲット・デバイス上に追加し、マップで

きます。同時にマッピングできるのは、CDドライブ1台と大容量記憶装置1台で

す。

• CD／DVDドライブ、ディスク・イメージ・ファイル( ISOまたはフロッピーのイ

メージ・ファイルなど) は、バーチャルCD／DVD-ROMドライブとしてマッピン

グされます。

• フロッピー・ドライブ、USBメモリー・デバイス、その他のメディア・タイプは、

バーチャル大容量記憶装置としてマッピングされます。

OBWIを使用するバーチャル・メディア・セッション設定の構成に関する詳細は、「

バーチャル・メディア・セッションの設定」( ページ79) を参照してください。

要件

デバイスは、バーチャル・メディアをサポートし、USB2またはUSB2およびCAC

用SIPを備えたKVMスイッチに接続されている必要があります。



98xxx |ビデオ・ビューアxxx

ターゲット・デバイスは、バーチャルにマッピングしようとしているUSB2対応メディ

ア・タイプを利用可能なデバイスである必要があります。 すなわち、ターゲット・デ

バイスがポータブルUSBメモリー・デバイスをサポートしていない場合は、クライア

ント・デバイス上のメモリー・デバイスをバーチャル・メディア・ドライブとしてターゲ

ット・デバイスにマップすることはできません。

ユーザー(またはユーザーが所属するユーザー・グループ) には、ターゲット・デ

バイスに対するバーチャル・メディア・セッションや予約済みバーチャル・メディア・

セッションを確立するアクセス権が必要です。「ローカル・ユーザー・アカウントの

設定」( ページ77) を参照してください。

ターゲット・デバイスに対してアクティブにできるバーチャル・メディア・セッション

は、一度に1つだけです。

共有およびプリエンプト操作の考慮事項

KVMセッションとバーチャル・メディア・セッションは別個のものです。従って、共

有／専用／プリエンプト・セッションには多くのオプションがあります。 Avocent管

理ソフトウェアには、さまざまなシステム・ニーズに対応できる柔軟性があります。

たとえば、KVMセッションとバーチャル・メディア・セッションを同時にロックできま

す。このモードでは、KVMセッションの接続が解除されると、関連付けられている

バーチャル・メディア・セッションの接続も解除されます。 これらのセッションが同

時にロックされていない場合は、バーチャル・メディア・セッションをアクティブにし

たまま、KVMセッションを終了できます。この機能は、ユーザーがバーチャル・メ

ディア・セッションを使用して時間がかかるタスク( オペレーティング・システムの

ロードなど) を実行しているときに、処理の進行中に他の機能を実行するために異

なるターゲット・デバイスとKVMセッションを確立したい場合などに役立ちます。

関連するKVMセッションなしにバーチャル・メディア・セッションがターゲット・デバ

イスでいったんアクティブになった場合は、そのチャンネルにオリジナル・ユー

ザー( ユーザーA) が再接続するか、別のユーザー( ユーザーB) が接続できま

す。Virtual Mediaダイアログ・ボックスにあるオプション( Reserved) を設定する

と、KVMセッションでそのチャンネルへのアクセスをユーザーAにのみ許可できま

す。

ユーザーBにこのKVMセッションへのアクセスを許可した( 「Reserved」オプション

が無効になっている)場合は、ユーザーBがバーチャル・メディア・セッションで使
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用されているメディアを制御できます。ティアド( 階層) 接続環境で「Reserved」オ

プションを使用すると、ユーザーAにのみ下層スイッチへのアクセスを許可し、また

上層スイッチと下層スイッチ間のKVMチャンネルをユーザーA用に予約できます。

「Virtual Media」ダイアログ・ボックス

Virtual Mediaダイアログ・ボックスでは、バーチャル・メディアのマッピングとアン

マッピングを管理できます。このダイアログ・ボックスには、バーチャル・ドライブと

してマッピング可能なクライアント・デバイス上の物理ドライブがすべて表示されま

す。Virtual Mediaダイアログ・ボックスを使用すると、ISOやフロッピーのイメージ・

ファイルを追加した後で、それらをマッピングすることもできます。

デバイスをマッピングすると、Virtual Mediaダイアログ・ボックスの詳細表示に、転

送されたデータ量と、デバイスのマッピング後に経過した時間に関する情報が表

示されます。

バーチャル・メディア・セッションは、予約済みとして指定できます。セッションが予

約され、関連付けられているKVMセッションが終了した場合は、他のユーザーがこ

のターゲット・デバイスへのKVMセッションを起動することはできません。 セッショ

ンが予約されていない場合は、別のKVMセッションを起動できます。

Virtual Mediaダイアログ・ボックスからは、SIPをリセットすることもできます。この

操作により、ターゲット・デバイス上のすべてのUSBメディアがリセットされます。こ

の操作はターゲット・デバイスが応答しない場合にのみ、注意して実行してくださ

い。

バーチャル・メディア・セッションの開始

バーチャル・メディア・セッションを起動するには次の手順を実行します。

ビデオ・ビューアのメニューから、Tools →Virtual Mediaを選択します。Virtual

Mediaダイアログ・ボックス(図 5.4) が表示されます。セッションを予約済みにする

には、Detailsをクリックしてから、Reservedチェックボックスをオンにします。
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図5.4:ビデオ・ビューアの「バーチャル・メディア」ダイアログ・ボックス

バーチャル・メディア・ドライブをマッピングするには次の手順を実行します。

1 ビデオ・ビューアのメニューからTools →Virtual Mediaを選択してバーチャル・

メディア・セッションを開始します。

2 バーチャル・メディア・ドライブとして物理ドライブをマッピングするには次の手

順を実行します。

a. Virtual Mediaダイアログ・ボックスで、マッピングするドライブの横にあ

るMappedチェックボックスをオンにします。

b. マップしようとしているドライブを読み取り専用アクセスに制限したい場合

は、ドライブの横にあるRead Only チェックボックスをオンにします。マッ

ピングされたすべてのドライブがバーチャル・メディア・セッションの設定

で既に読み取り専用になっている場合は、このチェックボックスがあらか

じめオンになり、これを変更することはできません。



ビデオ・ビューアxxx | xxx101

セッションの設定で読み取り／書き込みアクセスが有効になって

いるものの、特定のドライブへのアクセスを読み取り専用に制限

したい場合は、Read Onlyチェックボックスをオンにします。

3 ISOまたはフロッピー・イメージをバーチャル・メディア・ドライブとして追加して

マッピングするには次の手順を実行します。

a. Virtual Mediaダイアログ・ボックスで、Add Imageをクリックします。

b. 共通のファイル・ダイアログ・ボックスが表示され、ディスク・イメージ・ファ

イル( .isoか.imgの拡張子を持つファイル) を格納しているディレクトリが表

示されます。ISOまたはフロッピー・イメージ・ファイルを選択して、Openを

クリックします。

-または-

クライアント・デバイスのオペレーティング・システムがドラッグ・

アンド・ドロップをサポートしている場合は、ISOまたはフロッ

ピー・イメージ・ファイルを共通ファイル・ダイアログ・ボックスか

ら選択し、それをVirtual Mediaダイアログ・ボックスにドラッグし

ます。

c. 確認のため、ファイル・ヘッダーにチェック印がつきます。チェック印がつ

くと共通ファイル・ダイアログ・ボックスが閉じ、選択したイメージ・ファイル

がVirtual Mediaダイアログ・ボックスに表示されます。このダイアログ・ボ

ックスのMappedチェックボックスをオンにすると、ファイルのマッピングが

可能になります。

d. 他にもISOやフロッピー・イメージを追加したい場合は、これらの手順を繰

り返します。イメージ・ファイルは( メモリーの容量範囲内で)いくつでも追

加できますが、バーチャルのCD、DVDまたは大容量記憶装置は同時に1

つしかマッピングできません。

マッピングしようとしているドライブの数が多すぎたり( 1台のCDまたはDVDドライ

ブと1台の大容量記憶装置) 、特定タイプのドライブの数が多すぎる( 2台以上のCD

またはDVDドライブか大容量記憶装置)場合は、メッセージが表示されます。新し

いドライブをマッピングする場合は、まず現在マッピングされているドライブをアン

マップしてから別のドライブをマッピングする必要があります。



102xxx |ビデオ・ビューアxxx

物理ドライブかイメージのマッピングが完了すると、ターゲット・デバイスで使用で

きるようになります。

バーチャル・メディア・ドライブをアンマップするには次の手順を実行します。

1 Virtual Mediaダイアログ・ボックスで、アンマップするドライブの横にあ

るMappedチェックボックスをオフにします。

2 確認を求めるメッセージが表示されます。アンマップを確定するか、キャンセ

ルします。

3 アンマップするバーチャル・メディア・ドライブごとに上記の手順を繰り返しま

す。

バーチャル・メディア・ドライブの詳細を表示するには次の手順を実行します。

Virtual Mediaダイアログ・ボックスで、Detailsをクリックします。ダイアログ・ボック

スが拡張され、 「Details」の表が表示されます。各行の情報は、次のとおりです：

• ターゲット・ドライブ － マッピングされたドライブの名前( バーチャルCD 1や

バーチャルCD 2など) 。

• マッピング先－ 「クライアント表示」の「ドライブ」列に表示されているドライブ

情報と同じ。

• 読み取りバイト数および書き込みバイト数 －マッピングを行ってから転送さ

れたデータ量。

• 継続時間－ドライブをマッピングしてから経過した時間。

「Details」ビューを閉じるには、Detailsを再度クリックします。

ターゲット・デバイス上のすべてのUSBデバイスをリセットするには次の手順を実

行します。

注: USBリセット機能は、ターゲット・デバイス上のすべてのUSBメディア(マウスおよ
びキーボードを含む)をリセットします。 この操作を実行するのはターゲット・デバイ
スが応答しない場合のみに限定してください。

1 Virtual Mediaダイアログ・ボックスで、Detailsをクリックします。

2 「Details」ビューが表示されます。USB Resetをクリックします。
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3 リセットした場合の影響を警告するメッセージが表示されます。 リセットを確定

するか、キャンセルします。

4 「Details」ビューを閉じるには、Detailsを再度クリックします。

バーチャル・メディア・セッションの終了

Virtual Mediaダイアログ・ボックスを閉じるには次の手順を実行します。

1 Exitをクリックします。

2 マッピングしたドライブがある場合は、アンマップされる旨のメッセージが表示

されます。操作を確定するか、キャンセルします。

バーチャル・メディア・セッション、もしくはバーチャル・メディア・セッションが関連

付けられてロックされたアクティブなKVMセッションをユーザーが接続解除しようと

すると、バーチャル・メディアのマッピングが失われる旨の確認メッセージが表示

されます。

スマート･カード
クライアント･デバイスの利用可能なUSBポートにスマート･カード･リーダーを接続

して、スイッチ･システムに接続されているターゲット・デバイスにアクセスできま

す。その後、KVMセッションを起動してビデオ・ビューアを開き、スマート・カードを

マッピングできます。

注: すべてのスマート・カード・リーダーには、DellのUSB2およびCAC用SIPまた
はAvocent VMC IQモジュールを使用する必要があります。

スマート・カードの状態は、ビデオ・ビューアのツールバーの右端にあるスマート・

カード・アイコンに表示されます。次の表にスマート・カードのステータス・アイコン

の概要を示します。

アイコン 説明

スマート・カードがスマート・カード・リーダーに挿入されていない

か、またはスマート・カード・リーダーが接続されていません。

表 5.4: スマート･カードのアイコン
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アイコン 説明

スマート・カードはスマート・カード・リーダーに挿入されています

が、まだマッピングされていません。

スマート・カードはマッピングされています( 緑のアイコン) 。

スマート・カードをマッピングするには次の手順を実行します。

1 KVMセッションを開始し、「ビデオ・ビューア」ウィンドウのメニューを表示しま

す。

2 クライアント･デバイスに接続されているスマート･カード･リーダーにスマート･

カードを挿入します。

3 「ビデオ・ビューア」ウィンドウのメニューで、Tools →Map Smart Cardの順に

クリックします。

4 ターゲット・デバイスにマッピングされているスマート・カードがない場合は、「

マッピング済みのカードはありません」オプションの横にドットが表示されま

す。このオプションの下の一覧からスマート・カードを選び、スマート・カードを

マッピングします。

スマート・カードをアンマップするには、「ビデオ・ビューア」ウィンドウのメニュー

でXをクリックしてKVMセッションを終了し、Tools →No Card Mappedの順に選択

し、スマート・カード・リーダーからスマート・カードを取り外すか、またはスマート・

カード・リーダーとクライアント・サーバーとの接続を解除します。

キーボード・パススルー
ユーザーが入力するキーストロークは、「ビデオ・ビューア」ウィンドウの画面表示

モードに従って2種類に解釈されます。

• 「ビデオ・ビューア」ウィンドウが全画面表示( Full Screen) モードの場合、すべ

てのキーストロークおよびCtrl-Alt-Delを除くキーストロークの組み合わせの

すべてが、表示中のリモート・ターゲット・デバイスに送られます。

• 「ビデオ・ビューア」ウィンドウが通常のデスクトップ・モードの場合、特定の

キーストロークやキーの組み合わせをリモート・ターゲット・デバイスとローカ
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ル・コンピューターのどちらで認識させるようにするかを、キーボード・パスス

ルー・モードによって制御できます。

これには、キーボード・パススルーをSession Optionsダイアログ・ボックスで設定

する必要があります。キーボード・パススルー・モードが有効になっていると、「ビ

デオ・ビューア」ウィンドウがアクティブであれば、すべてのキーストロークおよ

びCtrl-Alt-Delを除くキーストロークの組み合わせのすべてが、表示中のリモー

ト・ターゲット・デバイスに送られます。ローカル・デスクトップがアクティブになっ

ている場合、ユーザーが入力したキーストロークとキーストロークの組み合わせ

はローカル・コンピューターに反映されます。

注: Ctrl-Alt-Deleteのキーストロークの組み合わせは、マクロを使用しなければリ
モート・ターゲット・デバイスに送ることはできません。

注: 日本語キーボードのALT - 半角／全角キーストロークの組み合わせは、画面
モードやキーボード・パススルー・モードの設定に関係なく、常にリモート・ターゲッ
ト・デバイスに送られます。

キーボード・パススルーを指定するには：

1 「ビデオ・ビューア」ウィンドウのメニューからTools → Session Optionsを選択

します。

-または-

Session Optionsボタンをクリックします。

Session Optionsダイアログ・ボックスが表示されます。

2 Generalタブをクリックします。

3 Pass-through all keystrokes in regular window modeを選択します。

4 OKをクリックして設定内容を保存します。

マクロ
スイッチのOBWIには、Windows、Linux、およびSunのプラットフォーム用にマクロ

が既定されています。

マクロを実行するには、「ビデオ・ビューア」ウィンドウ・メニューからMacros → <

目的のマクロ>を選択するか、または「ビデオ・ビューア」メニューにあるボタンか

ら実行するマクロを選択します。
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表示の保存
「ビデオ・ビューア」の表示は、ファイルに保存するか、またはクリップボードにコ

ピーして、ワード・プロセッサーやその他のプログラムで使用できます。

「ビデオ・ビューア」ウィンドウをファイルにキャプチャーするには：

1 「ビデオ・ビューア」ウィンドウのメニューからFile →Capture to Fileの順に選

択します。

-または-

Capture to Fileボタンをクリックします。

Save Asダイアログ・ボックスが表示されます。

2 ファイル名を入力し、ファイルの保存先を指定します。

3 Saveボタンをクリックし、ウィンドウの表示をファイルに保存します。

「ビデオ・ビューア」ウィンドウをクリップボードにキャプチャーするには、「ビデオ・

ビューア」ウィンドウのメニューからFile → Capture to Clipboardの順に選択する

か、またはCapture to Clipboardボタンをクリックします。イメージ・データがクリッ

プボードに保存されます。

セッションの終了
「ビデオ・ビューア」ウィンドウ・セッションを終了するには次の手順を実行します。

「ビデオ・ビューア」ウィンドウからFile → Exitを選択します。
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ターミナル操作

各SCSは、10101セットアップ・ポートからアクセスされるターミナル・コンソールの

メニュー・インターフェイスを介して、スイッチ・レベルで構成できます。 すべての

ターミナル・コマンドは、ターミナルの画面またはターミナル・エミュレーション・ソフ

トウェアを実行しているPCを介してアクセスされます。

注:推奨方法は、ローカルUIでの構成設定です。

ターミナルをスイッチに接続するには次の手順を実行します。

1 DB9 M/Fシリアル・アダプターを使用して、ターミナルまたはターミナル・エミュ

レーション・ソフトウェア( HyperTerminal® など) を実行しているPCを、スイッ

チの背面パネル上の10101ポートに接続します。 ターミナル設定の種類

は、9600bps、8ビット、1ストップ・ビット、パリティなし、フロー・コントロールな

しです。

2 スイッチと各ターゲット・デバイスの電源をオンにします。スイッチの起動が完

了すると、コンソール・メニューに次のメッセージが表示されます：Press any

key to continue( 任意のキーを押して続行します) 。

ネットワーク設定
コンソール・メニューを使用してネットワーク設定を構成するには：

1 SCSをオンにすると、スイッチで約1分間初期化が行われます。初期化が完了

した後に、ターミナルまたはターミナル・エミュレーション・ソフトウェアを実行し

ているPC上で任意のキー押してコンソールのメニュー・インターフェイスにア

クセスします。
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このターミナルは、スイッチが既にオンになっているときも含めていつで

も接続することが可能です。

2 コンソールの「Main」メニューが表示されたら、Network Configurationに対応

する番号を入力して、Enterキーを押します。

3 1を入力しEnterキーを押してネットワーク速度を設定します。最高の性能を得

るため、SCSスイッチを接続されているイーサネット・スイッチの速度と同じに

設 定 し て く だ さ い。 Enter キー を 押 し て、「Transmitter Network

Configuration」メニューに戻ります。

4 2を入力しEnterキーを押して、静的IPアドレスとDHCP IPアドレスのどちらを使

用しているかを指定します。

静的IP構成を使用して、ユーザー定義のIPアドレス、ネットマスクまたはプ

レフィックス長、およびデフォルト・ゲートウェイをSCSに設定することが

できます。

DHCPは、TCP/IPが有効になっているコンピューターの構成を自動的に

行うプロトコルです。 DHCPが選択されていると、IPアドレス、ネットマスク

またはプレフィックス長、およびデフォルト・ゲートウェイ設定が自動的

にSCSに割り当てられ、スイッチのユーザーは変更できなくなります。

DHCPオプションを使用している場合は、DHCPデバイスを構成してスイッ

チに対するIPアドレスを指定し、手順6に進みます。

5 「Network Configuration」メニューから残りのオプションを選択して、IPアドレ

ス、ネットマスクまたはプレフィックス長、およびデフォルト・ゲートウェイを使

用してSCSの構成を終了します。

6 0( ゼロ) を入力しEnterキーを押してConsoleの「Main」メニューに戻ります。

コンソールの「Main」メニューのその他のオプショ
ン
「Network Configuration」オプション以外に、SCSのConsole「Main」メニューには

以下の項 目があ り ます：「Firmware Management」( フ ァームウ ェアの 管

理) 、「Enable Debug Messages」( デバッグ・メッセージの有効化) 、「Set/Change

Password」( パスワードの設定／変更) 、「Restore Factory Defaults」( 工場出荷時
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のデフォルト設定の復元) 、「Reset Switch」( スイッチのリセット) 、「Set Web

Interface Ports」( Webインターフェイス・ポートの設定) 、「Exit」( 終了) 。本節でそ

れぞれについて説明を加えます。

FirmwareManagement

このメニューには、「Flash Download」の選択が含まれています。詳細について

は、「ツール－再起動およびアップグレード」( ページ67) を参照してください。

Enable Debug Messages

このメニュー・オプションで、コンソール・ステータス・メッセージをオンにできます。

この操作を行うと性能が大幅に低減することがあるため、テクニカル・サポートか

らの指示を受けた場合にのみデバッグ・メッセージを有効にしてください。 メッセー

ジの閲覧が終了したら、任意のキーを押してこのモードを終了します。

Set/Change Password

このメニュー･オプションで、シリアル・ポートのセキュリテイを有効／無効にするこ

とができ、この操作によりユーザー定義のパスワードを使ってシリアル・ポートをロ

ックします。

Restore Factory Defaults

このメニュー・オプションで、スイッチのすべてのオプションをデフォルト設定に復

元できます。

Reset Switch

このメニュー・オプションでは、SCSのソフト・リセットを実行できます。

Set Web Interface Ports

SCSは、ポート80とポート443をHTTPおよびHTTPSポート番号のそれぞれに使用

します。ユーザーは変更したり、代わりのポートを指定することができます。

注:新しいポート番号を使用するに、SCSの再起動が必要です。

Exit

このメニューを選択すると、入力待機のプロンプトに戻ります。 コンソール・メニ

ュー・インターフェイスのパスワードが有効になっている場合には、次のユーザー
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にパスワードのログイン画面によるメッセージが出されるようにコンソール

の「Main」メニューを終了してください。
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付録 A: MIBとSNMPラップ

SCSには監査イベントをSNMPマネージャーに送信する機能があります。 SNMPト

ラップは、SNMPトラップMIBに定義されています。

「Save Trap MIB」機能を使用して、トラップMIBファイルをSCSからアップロードでき

ます。 その後、アップロードされたトラップMIBファイルは、SNMPトラップ・レシー

バー・アプリケーションに読み込むことができます。

この付録では、SCSによって生成される可能性があるトラップ・イベントを説明しま

す。この付録内の情報は、努めて最新のものとしていますが、実際のトラップMIB

ファイルに含まれているトラップ情報が最も正確です。

SNMPマネージャーは、IPv4またはIPv6プロトコルを使用して、SCSのMIB-IIオブジ

ェクトにアクセスできます。

設計上、SCS内の企業固有のMIBオブジェクトには、SNMPを使用してアクセスす

ることはできません。

SCSトラップの定義では、次のRFC( Request For Comments) で説明する構造を使

用しています。

• RFC-1155-SMI

TCP/IPベースのインターネットで使用する管理情報の定義に対する一般

的な構造と同定法を説明します。

• RFC-1212

簡潔で記述的なMIBモジュールを作成するための形式を説明します。

• RFC-1213-MIB
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TCP/IPベースのインターネットワークでのネットワーク管理プロトコルで

の使用に対するインターネット標準MIB-II を説明します。

• RFC-1215

SNMP標準トラップを説明し、企業固有のトラップを定義する方法を提供し

ます。各トラップによって報告される特定のオブジェクトは、SCSからアッ

プロードされたトラップMIBファイルに定義されています。次の表に、生成

されたトラップ・イベントの一覧を示します。

トラップ・イベント トラップ番号

ユーザー認証の失敗 1

ユーザー・ログイン 2

ユーザー・ログアウト 3

ターゲット・セッションが開始しました 4

ターゲット・セッションが停止しました 5

ターゲット・セッションが終了しました 6

トラップ7、8は未使用 7-8

ユーザーが追加されました 9

ユーザーが削除されました 10

ユーザーが変更されました 11

再起動が開始しました 12

イメージ・ファイルのアップグレードが開始しました 13

イメージ・ファイルのアップグレード結果 14

SIPが追加されました 15

表A.1:生成されたトラップ・イベント
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トラップ・イベント トラップ番号

SIPが取り外されました 16

ターゲット・デバイス名が変更されました 17

ティアド・スイッチが追加されました 18

ティアド・スイッチが取り外されました 19

ティアド・スイッチ名が変更されました 20

設定ファイルが読み込まれました 21

ユーザー・データベース・ファイルが読み込まれました 22

トラップ23～32は未使用 23-32

ユーザーはロック状態です 33

ユーザーはロック解除されています 34

SIPアップグレードが開始しました 35

SIPイメージのアップグレード結果 36

SIPが再起動しました 37

バーチャル・メディア・セッションが開始しました 38

バーチャル・メディア・セッションが停止しました 39

バーチャル・メディア・セッションが終了しました 40

バーチャル・メディア・セッションは予約されています 41

バーチャル・メディア・セッションが予約解除になりました 42

バーチャル・メディア・セッションがマッピングされました 43
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トラップ・イベント トラップ番号

バーチャル・メディア・ドライブがマッピング解除されました 44

トラップ45～75は未使用 45-75

スマート・カードが挿入されました 76

スマート・カードが取り外されました 77

トラップ78、79は未使用 78-79

集約ターゲット・デバイスの状態が変更されました 80
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付録 B: セットアップ・ポートのピン
配列

SCSの10101セットアップ・ポートは、8ピン・モジュラー( RJ-45) のジャックです。

セットアップ・ポートのピン配列と説明を次の図および表に示します。

図B.1:セットアップ・ポートのピン配列

ピン番号 説明 ピン番号 説明

1 接続なし 5
送信デー

タ( TXD：Transmit Data)

2 接続なし 6
信号用接地( SG：Signal
Ground)

3 接続なし 7 接続なし

4
データ受

信( RXD：Receive
Data)

8 接続なし

表B.1:コンソール／セットアップ・ポートのピン配列の説明
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付録 C: AvocentシリアルIQモジ
ュールの使用法

シリアルIQモジュールは、シリアル－VGA間の変換器で、VT100の対応デバイス

がスイッチのローカル・ポート、OBWIからまたはスイッチ・ソフトウェアを使用して

参照できるようにします。 デバイスからのシリアル・データはすべて読み取り専用

です。このデータは、VGAデバイスから送信されたかのごとく、VT100ウィンドウに

表示され、ビデオ・バッファーに収納されて、スイッチに送信されます。 同様に

キーボードから入力したキーストロークも、まるでVT100ターミナル上でタイプした

ように、接続デバイスに送信されます。

シリアルIQモジュール・モード
シリアルIQモジュールからは次のモードが利用できます：

• On-Line：このモードではシリアル・データを送受信することができます。

• Configuration：このモードでは、スイッチの通信パラメーター、ターミナル・ア

プリケーション・メニューの表示形態、特定アクションやマクロのキー・コンビ

ネーションを指定することができます。

• History:このモードではシリアル・データを表示することができます。

シリアルIQモジュールの構成
注: シリアルIQモジュールは、VT100ターミナル・エミュレーションのみをサポートす
るDCEデバイスです。



付録 C: AvocentシリアルIQモジュールの使用法xxx | xxx118

Ctrl-F8キーを押すと、IQモジュールのターミナル・アプリケーション・メニュー

の「Configuration」画面がアクティブになります。この画面でシリアルIQモジュール

の構成ができます。

注: ターミナル・アプリケーション・メニューがアクティブになっているときに、Enter
キー押すと、変更内容が保存され、前の画面に戻ります。 変更内容を保存せずに
前の画面に戻るには、Escapeキーを押します。

ターミナル・アプリケーション・メニュー内の「Configuration」画面では、以下のオプ

ションを変更することができます：

• Baud Rate( ボー･レート) ：このオプションで、シリアル・ポートの通信速度を指

定 し ま す。 使 用 可 能 な 設 定 値

は300、1200、2400、9600、19,200、34,800、57,600または115,200 bpsです。

デフォルト値は、9600です。

• Parity( パリティー) ：このオプションで、シリアル・ポート用の通信パリティを指

定します。EVEN( 偶数パリティー) 、ODD( 奇数パリティー) 、またはNONE( パ

リティーなし) のオプションがあります。デフォルト値は、NONE( パリティーな

し)になっています。

• Flow Control( フロー制御) ：このオプションで、シリアル・フロー・コントロール

の種類を指定します。NONE( なし) 、XOn/XOff( ソフトウェア) 、RTS/CTS(

ハードウェア)のオプションがあります。デフォルト値は、NONE( パリティーな

し)になっています。bpsレートを115,200 に設定してある場合、使用可能なフ

ロー・コントロールはRTS/CTS( ハードウェア)のみとなります。

• Enter Sends：このオプションで、Enterキー押した時に送信するキーを指定す

ることができます。有効なオプションは、<CR>(Enterキー) - これではカーソル

が画面の左側に移動、または<CR><LF>(Enter-Linefeedキー) - これでは

カーソルが画面の左側、1行下に移動です。

• Received：このオプションで、モジュールで受信したEnterキーによるコマンド

をどう解釈させるかを指定します。有効なオプションは、<CR>(Enterキー)また

は<CR><LF>(Enter-Linefeedキー) です。

• Background：このオプションで画面の背景色を変更します。変更の際は、現在

選択されている色がオプション・ラインに表示されます。有効な色は、ブラッ

ク、ライトグレー、イエロー、グリーン、テール、シアン、ブルー、ダークブ
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ルー、パープル、ピンク、オレンジ、レッド、マローンおよびブラウンです。デ

フォルトの色はブラックです。Normal Text( 通常テキスト) またはBold Text(

太字テキスト) と同一の値は使用できません。

• Normal Text：このオプションで画面の通常テキスト色を変更します。変更の際

は、現在選択されている色がオプション・ラインに表示されます。有効な色は、

グレー、ライトグレー、イエロー、グリーン、テール、シアン、ブルー、ダークブ

ルー、パープル、ピンク、オレンジ、レッド、マローンおよびブラウンです。デ

フォルトの色はグレーです。Bold Text( 太字テキスト) またはBackground( 背

景) と同一の値は使用できません。

• Bold Text：このオプションで画面の太字テキスト色を変更します。変更の際

は、現在選択されている色がオプション・ラインに表示されます。有効な色は、

ホワイト、イエロー、グリーン、テール、シアン、ブルー、ダークブルー、パー

プル、ピンク、オレンジ、レッド、マローン、ブラウンおよびライトグレーです。

デフォルト の色は ホワ イト です。Normal Text( 通常テキスト) ま た

はBackground( 背景) と同一の値は使用できません。

• Screen Size：このオプションで画面のテキスト幅サイズを指定します。幅のオ

プションには、80コラムまたは132コラムがあります。どちらのコラム幅でも、

長さは26行です。

下記に挙げるターミナル・アプリケーション・メニューの「Configuration」画面用の

オプションでは、特定のアクションを実行するようファンクション・キーを定義するこ

とができます。 新しいファンクション・キーを指定するには、Ctrlキーを押した状態

で、アク シ ョ ン に 関 連づ け る フ ァン クシ ョ ン・ キー を押し ます。 例 え

ば、Configuration (Config) Key Sequencesのオプションを<Ctrl-F8>から<Ctrl-

F7>に変更したい場合には、Ctrlキーを押したままF7キーを押します。

• Config Key Sequences：このオプションで、ターミナル・アプリケーション・メニ

ューの「Configuration」画面を表示するためのキー・コンビネーションを定義

できます。デフォルトのキー・シーケンスは<Ctrl-F8>です。

• On-Line Key Sequence：このオプションで、On-Lineモードを表示するための

キー・コンビネーションを定義できます。デフォルトのキー・シーケンス

は<Ctrl-F10>です。
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• Help Key Sequence：このオプションで、「Help System」画面を表示するため

のキー・コンビネーションを定義できます。デフォルトのキー・シーケンス

は<Ctrl-F11>です。

• History Key Sequence：このオプションで、Historyモードを有効にするための

キー・コンビネーションを定義できます。デフォルトのキー・シーケンス

は<Ctrl-F9>です。

• Clear History Key Sequence：このオプションで、Historyモード時に履歴バッ

ファを消去するためのキー・コンビネーションを定義できます。デフォルトの

キー・シーケンスは<Ctrl-F11>です。

• Break Key Sequence：このオプションで、ブレーク条件を生成するキー・コン

ビネーションを設定できます。デフォルトのキー・シーケンスは<Alt-B>です。

シリアルIQモジュールを構成するには：

1 Ctrl-F8キーを押します。 「Configuration」画面が表示されます。

2 変更するパラメーターを選択します。 「Configuration」画面内の移動は、上向

き矢印または下向き矢印キーを使用して行います。

3 選択値の変更には、右向き矢印および左向き矢印キーを使用します。

4 変更する値が他にもある場合は、手順2～3を繰り返します。

5 Enterキーを押して変更内容を保存し、「Configuration」画面を終了します。

-または-

Escapeキーを押し、変更内容を保存せずに「Configuration」画面を閉じま

す。

シリアルIQモジュールでのマクロの作成
ターミナル・アプリケーション・メニューの「Configuration」画面が表示されている間

に、Page Downキーを押すと、「Macro Configuration」画面にアクセスできます。

このシリアルIQモジュールでは、最大で10種のマクロを構成できます。各マクロの

長さは128文字以内となっています。
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マクロを作成するには：

1 構成したいシリアルIQモジュールを選択し、Ctrl-F8キーを押して、ターミナル・

アプリケーション・メニューの「Configuration」画面をアクティブにします。

2 ターミナル・アプリケーション・メニューが表示されたら、Page Downキーを押

し、「Macro Configuration」画面を表示します。 「Macro Configuration」画面に

は、10種の利用可能なマクロ、および各マクロの関連キー・シーケンス(存在

する場合)が一覧されています。

3 上向き矢印または下向き矢印キーで利用可能なマクロの番号までスクロール

し、表示されているキーストローク・シーケンスを反転表示させます。 新しい

マクロ・キーストローク・シーケンスをデフォルト値の上に上書き入力します。

使用できるコンビネーションは、「Ctrlキー ＋単一キー」、または「Altキー＋

単一キー」です。新しいマクロを有効にするキーストローク・シーケンスを入

力したら、下向き矢印キーを押します。

4 入力したばかりのマクロ・キーストローク・シーケンスの下の行に、このマクロ

で実行したいキーストローク・シーケンスを入力します。

5 設定したいマクロが他にもある場合は、手順3～4を繰り返します。

6 終了したらEnterキーを押し、以前の画面に戻ります。

Historyモードの使用
Historyモードでは、履歴バッファー内のコンテンツを参照することができます。履

歴バッファーには過去のイベントが収納されています。

シリアルIQモジュールの場合、最小240行、または10画面分のバッファーが維持さ

れています。履歴バッファーが容量の限界に達すると、新たな行が最下行に加え

られるに連れて古い行が最上行から消去されるようになります。

注:後続の手順で使用されているConfig Key Sequence、On-Line Key Sequence、お
よびClear History Key Sequenceの値はデフォルト値です。 これらのキー・コンビ
ネーションはターミナル・アプリケーション・メニューを使用して変更できます。

Historyモードを使用するには：

1 Ctrl-F9キーを押します。 Historyモード表示になります。
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2 下記の中から、該当する操作を実行するためのキー・コンビネーションを押し

ます。

• Homeキー：バッファーの先頭に移動します。

• Endキー：バッファーの最後に移動します。

• Page Upキー：バッファー内で１ページ分上に移動します。

• Page Downキー：バッファ内で１ページ分下に移動します。

• 上向き矢印キー：バッファー内で１行上に移動します。

• 下向き矢印キー：バッファー内で１行下に移動します。

• Ctrl-F8キー：Configurationモードに移行します。「Configuration」画面が

表示されます。

• Ctrl-F9キー：Configurationモードの間は、Historyモード有効の場合に、

以前の画面に戻ります。

• Ctrl-F10キー：Configurationモードの間は、On-Lineモード有効の場合

に、以前の画面に戻ります。

• Ctrl-F11キー：履歴バッファをクリアします。このオプションを選択すると、

警告メッセージが表示されます。Enterキー押すと履歴バッファーは削除

され、Escapeキーを押すとこの操作は実行されずにキャンセルされます。

以前の画面が再び表示されます。

3 終了したらCtrl-F10キーを押してHistoryモードを終了し、On-Lineモードに戻

ります。

シリアルIQモジュールのピン配列
次の表は、シリアルIQモジュールのピン配列を一覧にしたものです。
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DB9-
Fピン

ホスト信号名／説明

信号

フロー SRL信号名／説明

1
DCD - Data Carrier Detect( データ・

キャリア検出)
SRLか
ら

DTR - Data Terminal Ready( デー

タ・ターミナル・レディー)

2 RXD - Receive Data( 受信データ)
SRLか
ら

TXD - Transmit Data( 送信データ)

3 TXD - Transmit Data( 送信データ)
SRLへ

RXD - Receive Data( 受信データ)

4
DTR - Data Terminal Ready( デー

タ・ターミナル・レディー)
SRLへ DSR - Data Set Ready( データ・セッ

ト・レディー)

5
GND - Signal Ground( 信号用接

地)
なし

GND - Signal Ground( 信号用接

地)

6
DSR - Data Set Ready( データ・セッ

ト・レディー)
SRLか
ら

DTR - Data Terminal Ready( デー

タ・ターミナル・レディー)

7
RTS - Request to Send( 送信要

求)
SRLへ

CTS - Clear to Send( 送信可)

8 CTS - Clear to Send( 送信可)
SRLか
ら

RTS - Request to Send( 送信要

求)

9 N/C - Not Connected( 未接続) なし N/C - Not Connected( 未接続)

表C.1:シリアルIQモジュールのピン配列
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付録 D: Sunキーボードのアドバン
スト・キー・エミュレーション

標準のタイプ5 (US) Sunキーボードのキーの一部には、キープレス・シーケンスで

ローカル・ポートのUSBキーボードにエミュレートできるものがあります。 Sun

Advanced Key Emulation( Sunアドバンスト・キー・エミュレーション) モードを有効

にしてこれらのキーを使用するには、Ctrl+Shift+Altキーを押したままScroll Lock

キーを押します。 Scroll LockのLEDが点滅します。 Sunキーボードのアドバンス

ト・キーを使用するのと同様に、次の表のキーを使用します。例：Stop+A

は、Ctrl+Shift+Altキーを押したままScroll Lockキーを押し、F1+Aキーを押しま

す。

これらのキー・コンビネーションは、Dell USB、USB2、USB2とCAC用SIPおよ

びAvocent USB、USB2、VMC IQモジュールで使用できます。 これらのキー・コン

ビネーションは、F12を除き、Microsoft Windows製品では認識されません。 F12

キーは、Windowsのキープレスを実行します。 終了したら、Ctrl+Shift+Altキーを

押したまま Scroll Lockキーを押し、Sunアドバンスト･キー・エミュレーション･モード

を切り替えてオフにします。

Compose アプリケーション(1)

Compose キーパッド

Power F11キー

Open F7キー

表D.1: Sunキー・エミュレーション
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Help Num Lockキー

Props F3キー

Front F5キー

Stop F1キー

Again F2キー

Undo F4キー

Cut F10キー

Copy F6キー

Paste F8キー

Find F9キー

Mute キーパッド／

Vol.+ キーパッド+

Vol.- キーパッド -

Command (left)(2) F12キー

Command (left)(2) Win (GUI)左(1)

Command (right)(2) Win (GUI)右(1)

備考：

(1)Windows 95 104キー・キーボード。

(2)CommandキーはSun Meta( ダイヤモンド ) キーです。
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付録 E: UTPケーブル配線

以下に、接続媒体のさまざまな特徴を説明します。 SCSシステムではUTPケーブ

ル配線を使用します。 システムの性能は、高品質の接続が得られるかどうかに依

存します。品質の低いケーブル、設置や保守に問題のあるケーブルは、SCSシス

テムの性能を損なう結果となる場合があります。

注: この付録は情報の提供のみを目的としています。 設置する前に、当地のコード
当局やケーブル関連の専門家に確認してください。

銅製UTPケーブル
SCSでサポートされている3種類のUTPケーブルの基本的な定義は次のとおりで

す。

• CAT 5 ( 4ペア) 高性能ケーブルは、ツイスト・ペア電線で構成されており、主

にデータ送信に使用されます。ペア線がより合わされていることで、このケー

ブルでは不要な干渉の混入からある程度免れることができます。 CAT 5ケー

ブルは通常、10～100 Mbpsの範囲で動作するネットワークに使用します。

• CAT 5E( 強化) ケーブルの特徴はCAT 5と同様ですが、製造規格が若干厳し

いものになっています。

• CAT 6ケーブルは、CAT 5Eケーブルに比べより厳しい要件に合わせて製造さ

れています。 CAT 6はより高い測定周波数範囲を持ち、同一周波数において

はCAT 5Eに比べ明らかに分かる優れた性能要件を示します。

配線規格
8導線( 4ペ ア) RJ- 45終端処理済みUTPケーブルに は、EIA/TIA 568Aお よ

びEIA/TIA 568Bの2種類の推奨配線規格があります。これらの規格は、UTPケー
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ブル仕様によるインストールに適用されます。SCSシステムではこれらの配線規

格のいずれかがサポートされています。次の表は、各ピンの規格を説明していま

す。

ピン EIA/TIA 568A EIA/TIA 568B

1 白／緑 白／オレンジ

2 緑 オレンジ

3 白／オレンジ 白／緑

4 青 青

5 白／青 白／青

6 オレンジ 緑

7 白／茶 白／茶

8 茶 茶

表E.1: UTP配線規格

ケーブルの設置、保守、および安全情報
次に、ケーブルの設置や保守を実行する前に目を通しておくべき重要な安全注意

事項を一覧で示します。

• 各UTPケーブルの最高の長さは30 mとしてください。

• ペア線は、必ず終端箇所までツイストされた( より合わされた)状態を保つか、

またはツイストになっていない部分が1.3 cm( 半インチ) を超えないようにして

ください。終端処理の際、外被を2.5 cm( 1インチ)以上剥がさないでください。

• ケーブルを曲げる必要がある場合は、半径が2.5 cm( 1インチ) より小さくなら

ない範囲で緩やかに行ってください。ケーブルを鋭角に曲げたりねじったりす

ると、ケーブル内部に恒久的な損傷が生じるおそれがあります。
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• ケーブルは、ケーブル・タイを用いて低～中程度の圧力で束ねてまとめてくだ

さい。ケーブル・タイは締め過ぎないでください。

• ケーブルは必要に応じて、定格のパンチ・ブロック、パッチ・パネル、その他の

コンポーネントを用いて交差接続します。ケーブルは絶対に繋ぎ合わせたり

ブリッジにしたりしないでください。

• UTPケーブルは、電線、トランス、電灯などのようなEMI源となり得る品物から

はできるだけ距離を持たせてください。ケーブルを電線用導管に結びつけた

り、電気機器上に配置したりしないでください。

• 設置部分は必ずケーブル・テスターでテストしてください。 トーニングのみで

はテストとして適切ではありません。

• ジャックの設置は、接点に埃や他の汚染物質が蓄積しないような形で行ってく

ださい。ジャックの接点は、埋め込み型のプレート上では上向きに、表面実装

型ボックスの場合は左／右／下向きにします。

• ケーブルには常に遊びをもたせ、天井部分あるいは付近の引込んだ箇所に

はコイル状に整然と配置します。 少なくとも、コンセント側では1.5 m( 5フィー

ト) 、パッチ・パネル側では4.5 m( 15フィート)のケーブルの長さを残しておいて

ください。

• 作業を開始する前に、568Aと568Bのどちらの配線規格を使用するかを決め

ておいてください。 ジャックおよびパッチ・パネルはすべて、同一の配線方式

で配線します。同一の設置に568Aと568Bのワイヤーを混在させないでくださ

い。

• 常に、地方／国の消防規則および建築条例のすべてに従ってください。防火

壁を通過するケーブルには必ず火炎止めをしてください。 規定に応じてプレ

ナム・ケーブルを使用してください。
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付録 F: 技術仕様

ポートの個数
1081AD：8 AHI/ARI

2161AD：16 AHI/ARI

タイプ
Dell PS/2、USB、USB2、およびUSB2とCAC用SIP

Avocent PS/2、PS2M、USB、Sun、USB2、およびVMCモジュール。

コネクター 8ピン・モジュラー( RJ-45)

同期タイプ 垂直／水平同期信号分離

入力ビデオ解像度

標準

640 x 480 @ 60 Hz
800 x 600 @ 75 Hz
960 x 700 @ 75 Hz
1024 x 768 @ 75 Hz
1280 x 1024 @ 75 Hz
1600 x 1200 @ 60 Hz
ワイドスクリーン

800 x 500 @ 60 Hz
1024 x 640 @ 60 Hz
1280 x 800 @ 60 Hz
1440 x 900 @ 60 Hz
1680 x 1050 @ 60 Hz

表F.1: SCS技術仕様
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ターゲット解像度

標準

1024 x 768 @ 60 Hz( 推奨)
1280 x 1024 @ 60 Hz ( 推奨)
1600 x 1200 @ 60 Hz ( 推奨)
ワイドスクリーン

1280 x 800 @ 60 Hz( 推奨)
1680 x 1050 @ 60 Hz( 推奨)

推奨ケーブル 4ペアUTP、最長30メートル

寸法

フォーム・ファクター 1Uまたは0Uラック収納

寸法
4.32 x 43.18 x 23.93 cm (高さ x幅 x奥行き)

( 1.70 x 17.00 x 9.42インチ)

重量( ケーブルを

除く)
1081AD：2.71 kg( 5.98 lb) ; 2161AD：2.79 kg( 6.16 lb)

10101セットアップ・ポート

個数 1

プロトコル RS-232シリアル

コネクター 8ピン・モジュラー( RJ-45)

ローカル・ポート

個数／タイプ

8ポート

1 VGA - HDD15

4 USB

16ポート

2 VGA - HDD15

8 USB

ネットワーク接続
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個数 2

プロトコル 10/100 Ethernet

コネクター 8ピン・モジュラー( RJ-45)

USBポート

個数 4

プロトコル USB 2.0

電源仕様

コネクター
1081AD：1 IEC C14

2161AD：2 IEC C14

タイプ 内部

電源 18W

発熱量 47 BTU/時

AC入力範囲 100～240 VAC

AC周波数 50/60 Hz自動検知

AC定格入力電流 0.6A

AC入力電力( 最
大)

20 W

周囲温度・湿度( 動作／保存)

温度
作動時：摂氏0～50度( 華氏32～122度)

非作動時：摂氏-20～70度( 華氏-4～158度)
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湿度
作動時：20%～80%相対湿度( 結露なし)

非作動時：5%～95%相対湿度、38.7℃ 最大湿球温度

安全認証、EMC規
格認証、マーキン

グ類

UL / cUL、CE - EU、N (Nemko)、GOST、C-Tick、NOM
/NYCE、KCC、SASO、Nemko GS、 IRAM、FCC、
ICES、VCCI、SoNCAP、SABS、Bellis、Koncar、 INSM、STZ、KUCAS

本製品に関する安全性証明書およびEMC証明書は、次の名

称( １つまたは複数) の下でご入手いただけます：CMN( 証明書モ

デル番号) 、MPN( 製造元部品番号) 、販売段階で付く型式名

称。EMCおよび／または安全性の報告書および証明書で参照さ

れている名称は、本製品のラベルに印刷されています。
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付録 G: テクニカル・サポート

Dell製品のインストールや操作について問題や疑問点が生じた場合には当社のテ

クニカル・サポートまでご連絡ください。担当スタッフがお手伝いいたします。万一

問題が生じた場合は、より良いサービスをお受けいただけるよう、次の手順に従

ってください。

問題を解決するには：

1 問題の該当箇所をマニュアルで調べ、記載されている手順に従って解決でき

るかどうかを試してください。

2 弊社のWebサイト( dell.com/support) にある「Knowledge Base( ノレッジ・ベー

ス) 」のデータベースからご検索いただくか、または「Online Service Request(

オンライン・サービス・リクエスト) 」をご利用ください。

3 最寄りのDellテクニカル・サポートまでお電話にてご連絡ください。
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